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Warranty
The media on which you receive National Instruments software are warranted not to fail to execute programming
instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evid
by receipts or other documentation. National Instruments will, at its option, repair or replace software media that 
execute programming instructions if National Instruments receives notice of such defects during the warranty pe
National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outs
of the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping
of returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this document is accurate. The document has been carefull
reviewed for technical accuracy. In the event that technical or typographical errors exist, National Instruments re
the right to make changes to subsequent editions of this document without prior notice to holders of this edition. 
reader should consult National Instruments if errors are suspected. In no event shall National Instruments be liab
any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL  INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS 
ANY WARRANTY OF MERCHANTABILITY  OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’ S RIGHT TO RECOVER DAMAGES CAUSED 
BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL  INSTRUMENTS SHALL BE LIMITED  TO THE AMOUNT THERETOFORE PAID BY THE 
CUSTOMER. NATIONAL  INSTRUMENTS WILL  NOT BE LIABLE  FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, 
OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability of 
National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence.
Any action against National Instruments must be brought within one year after the cause of action accrues. Natio
Instruments shall not be liable for any delay in performance due to causes beyond its reasonable control. The wa
provided herein does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to 
the National Instruments installation, operation, or maintenance instructions; owner’s modification of the product;
owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third partie
or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mecha
including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, wit
the prior written consent of National Instruments Corporation.

Trademarks
HS488™, natinst.com™, and NI-488.2™ are trademarks of National Instruments Corporation.

Product and company names mentioned herein are trademarks or trade names of their respective companies.

WARNING REGARDING MEDICAL AND CLINICAL USE OF NATIONAL INSTRUMENTS PRODUCTS
National Instruments products are not designed with components and testing for a level of reliability suitable for u
or in connection with surgical implants or as critical components in any life support systems whose failure to perf
can reasonably be expected to cause significant injury to a human. Applications of National Instruments products
involving medical or clinical treatment can create a potential for death or bodily injury caused by product failure, 
errors on the part of the user or application designer. Because each end-user system is customized and differs f
National Instruments testing platforms and because a user or application designer may use National Instruments p
in combination with other products in a manner not evaluated or contemplated by National Instruments, the user 
application designer is ultimately responsible for verifying and validating the suitability of National Instruments prod
whenever National Instruments products are incorporated in a system or application, including, without limitation
the appropriate design, process and safety level of such system or application.
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This manual describes the NI-488 functions and NI-488.2 routines of t
NI-488.2 software. The NI-488.2 software for Windows is meant to be u
with Windows 95, Windows 98, or Windows NT version 4.0 or later wit
the Microsoft Windows NT Advanced Server version 4.0 or later. This 
manual assumes that you are already familiar with the Windows system
are using.

Overview of the NI-488.2 Documentation
All of the NI-488.2 documentation is available on the NI-488.2 for 
Windows CD. The following documents can help you learn about and u
the NI-488.2 software and GPIB hardware.

• The Getting Started card briefly describes how to install your NI-488.2
software and GPIB hardware.

• The NI-488.2 User Manual for Windows describes the features and 
functions of the NI-488.2 software for Windows.

• The NI-488.2 Function Reference Manual for Windows describes the 
NI-488.2 API.

• The GPIB Hardware Guide contains detailed instructions about how t
configure and install your GPIB hardware. The hardware guide als
includes hardware and software specifications and compliance 
information.

You can access each of these documents online by inserting your NI-488.2 
for Windows CD and selecting the View Documentation option from the 
autorun menu. You can also view documentation at the National 
Instruments web site, www.natinst.com/manuals/ .

• The online NI-488.2 Help addresses questions you might have abou
NI-488.2 and includes troubleshooting information and descriptions
the NI-488.2 API.

To access the NI-488.2 online help, first open Measurement & 
Automation Explorer by selecting Start»Programs»National 
Instruments NI-488.2»Explore GPIB. Then, expand the Devices 
and Interfaces item, select a GPIB interface, right-click, and select
NI-488.2 Help.
© National Instruments Corporation xi NI-488.2 Function Reference Manual for Windows
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Conventions Used in This Manual
This manual uses the following conventions:

» The » symbol leads you through nested menu items and dialog box opt
to a final action. The sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup item, and select Options 
from the last dialog box.

This icon denotes a note, which alerts you to important information.

bold Bold text denotes the names of menus, menu items, parameters, dialo
boxes, dialog box buttons or options, icons, windows, Windows tabs, 
or LEDs.

IEEE 488.1 and IEEE 488 and IEEE 488.2 refer to the ANSI/IEEE Standard 488.1-1987 
IEEE 488.2 and the ANSI/IEEE Standard 488.2-1992, respectively, which define 

the GPIB.

italic Italic text denotes emphasis, a cross reference, or an introduction to a
concept.

monospace Text in this font denotes text or characters that are to be literally enter f
the keyboard, sections of code, programming examples, and syntax 
examples. This font is also used for the proper names of disk drives, pa
directories, programs, subprograms, subroutines, device names, funct
constants, variables, filenames, and extensions, and for statements an
comments taken from program code.

Related Documentation
The following documents contain information that you might find helpf
as you read this manual:

• ANSI/IEEE Standard 488.1-1987, IEEE Standard Digital Interface 
for Programmable Instrumentation

• ANSI/IEEE Standard 488.2-1992, IEEE Standard Codes, Formats, 
Protocols, and Common Commands

• Microsoft Win32 Software Development Kit for Microsoft Windows
NI-488.2 Function Reference Manual for Windows xii © National Instruments Corporation
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NI-488.2 API:
Traditional Calls

This chapter lists the traditional calls of the NI-488.2 API and describes the purpose, fo
input and output parameters, and possible errors for each function.

For general programming information, refer to the online help for the NI-488.2 software
available through Measurement & Automation Explorer. This help file explains how to 
develop and debug your program. To start Measurement & Automation Explorer, selec
Start»Programs»National Instruments NI-488.2»Explore GPIB. Then, select a GPIB 
interface under Devices and Interfaces, right-click, and choose NI-488.2 Help to view the 
online help.

Function Names
The functions in this chapter are listed alphabetically. Each function is designated as b
level, device level, or both.

Purpose
Each function description includes a brief statement of the purpose of the function.

Format
The format section describes the format of each function in the following languages: 
Microsoft Visual C/C++ (version 2.0 or later), Borland C/C++ (version 4.0 or later), 
and Microsoft Visual Basic (version 4.0 or later).

Input and Output
The input and output parameters for each function are listed. Function Return describe
return value of the function.
nual for Windows
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Description
The description section gives details about the purpose and effect of each function.

Examples
Some function descriptions include sample code showing how to use the function. For 
detailed and complete examples, refer to the example programs that are installed with
NI-488.2 software.

Possible Errors
Each function description includes a list of errors that could occur when it is invoked.

List of NI-488.2 API: Traditional Calls
The following tables contain alphabetical lists of the traditional calls.

Table 1-1.  Traditional Calls: Device-Level

Function Purpose

ibask Return information about software configuration parameters

ibbna Change the access interface of a device

ibclr Clear a specific device

ibconfig Change the software configuration parameters

ibdev Open and initialize a device descriptor

ibeos Configure the end-of-string (EOS) termination mode or 
character

ibeot Enable or disable the automatic assertion of the GPIB EOI lin
at the end of write I/O operations

ibln Check for the presence of a device on the bus

ibloc Go to Local

ibnotify Notify user of one or more GPIB events by invoking the user
callback

ibonl Place the device online or offline
NI-488.2 Function Reference Manual for Windows 1-2 © National Instruments Corporation
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ibpad Change the primary address

ibpct Pass control to another GPIB device with Controller capabilit

ibppc Parallel poll configure

ibrd Read data from a device into a user buffer

ibrda Read data asynchronously from a device into a user buffer

ibrdf Read data from a device into a file

ibrpp Conduct a parallel poll

ibrsp Conduct a serial poll

ibsad Change or disable the secondary address

ibstop Abort asynchronous I/O operation

ibtmo Change or disable the I/O timeout period

ibtrg Trigger selected device

ibwait Wait for GPIB events

ibwrt Write data to a device from a user buffer

ibwrta Write data asynchronously to a device from a user buffer

ibwrtf Write data to a device from a file

Table 1-2.  Traditional Calls: Board-Level

Function Purpose

ibask Return information about software configuration parameters

ibcac Become Active Controller

ibcmd Send GPIB commands

ibcmda Send GPIB commands asynchronously

ibconfig Change the software configuration parameters

ibdma Enable or disable DMA

Table 1-1.  Traditional Calls: Device-Level (Continued)

Function Purpose
© National Instruments Corporation 1-3 NI-488.2 Function Reference Manual for Windows
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ibeos Configure the end-of-string (EOS) termination mode or 
character

ibeot Enable or disable the automatic assertion of the GPIB EOI lin
at the end of write I/O operations

ibfind Open and initialize an interface

ibgts Go from Active Controller to Standby

ibist Set or clear the interface individual status bit for parallel poll

iblines Return the status of the eight GPIB control lines

ibln Check for the presence of a device on the bus

ibloc Go to Local

ibnotify Notify user of one or more GPIB events by invoking the user
callback

ibonl Place the interface online or offline

ibpad Change the primary address

ibppc Parallel poll configure

ibrd Read data from a device into a user buffer

ibrda Read data asynchronously from a device into a user buffer

ibrdf Read data from a device into a file

ibrpp Conduct a parallel poll

ibrsc Request or release system control

ibrsv Request service and change the serial poll status byte

ibsad Change or disable the secondary address

ibsic Assert interface clear

ibsre Set or clear the Remote Enable (REN) line

ibstop Abort asynchronous I/O operation

ibtmo Change or disable the I/O timeout period

ibwait Wait for GPIB events

Table 1-2.  Traditional Calls: Board-Level (Continued)

Function Purpose
NI-488.2 Function Reference Manual for Windows 1-4 © National Instruments Corporation
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ibwrt Write data to a device from a user buffer

ibwrta Write data asynchronously to a device from a user buffer

ibwrtf Write data to a device from a file

Table 1-2.  Traditional Calls: Board-Level (Continued)

Function Purpose
© National Instruments Corporation 1-5 NI-488.2 Function Reference Manual for Windows
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IBASK
Board Level/Device Level

Purpose
Return information about software configuration parameters.

Format
C
int ibask (int ud, int option, int *value)

Visual Basic
CALL ibask (ud%, option%, value%)

or

status% = ilask (ud%, option%, value%)

Input
ud Interface or device unit descriptor
option Selects the configuration item whose value is being requested

Output
value Current value of the selected configuration item
Function Return The value of ibsta

Description
ibask  returns the current value of various configuration parameters for the specified inte
or device. The current value of the selected configuration item is returned in the intege
value . Tables 1-3 and 1-4 list the valid configuration parameter options for ibask .

Possible Errors
EARG option  is not a valid configuration parameter. See the ibask  options listed 

in Tables 1-3 and 1-4.
ECAP option  is not supported by the driver or the interface is not configured 

correctly.
EDVR Either ud is invalid or the NI-488.2 driver is not installed.
EOIP Asynchronous I/O is in progress.
NI-488.2 Function Reference Manual for Windows 1-6 © National Instruments Corporation
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Table 1-3 lists the options you can use with ibask  when ud is an interface descriptor or an 
interface index.

Table 1-3.  ibask  Board Configuration Parameter Options

Options (Constants) Returned Information

IbaAUTOPOLL zero = Automatic serial polling is disabled.
non-zero = Automatic serial polling is enabled.

Refer to the NI-488.2 online help for more information about
serial polling. To view the online help, select Start» 
Programs»National Instruments NI-488.2»Explore GPIB 
and select the Measurement & Automation icon. Then, select 
a GPIB interface under Devices and Interfaces, right-click, 
and choose NI-488.2 Help.

IbaCICPROT zero = The CIC protocol is disabled.
non-zero = The CIC protocol is enabled.

Refer to the NI-488.2 online help for more information about
device-level calls and bus management. To view the online 
help, select Start»Programs»National Instruments 
NI-488.2»Explore GPIB and select the Measurement & 
Automation icon. Then, select a GPIB interface under 
Devices and Interfaces, right-click, and choose NI-488.2 
Help.

IbaDMA zero = The interface does not use DMA for GPIB transfers.
non-zero = The interface uses DMA for GPIB transfers.
See ibdma .

IbaEndBitIsNormal zero = The END bit of ibsta  is set only when EOI or EOI plus 
the EOS character is received. If the EOS character is receiv
without EOI, the END bit is not set.
non-zero = The END bit is set whenever EOI, EOS, or EOI 
plus EOS is received.

IbaEOSchar The current EOS character of the interface.
See ibeos .

IbaEOScmp zero = A 7-bit compare is used for all EOS comparisons.
non-zero = An 8-bit compare is used for all EOS comparison
See ibeos .

IbaEOSrd zero = The EOS character is ignored during read operations
non-zero = Read operation is terminated by the EOS charac
See ibeos .
© National Instruments Corporation 1-7 NI-488.2 Function Reference Manual for Windows
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IbaEOSwrt zero = The EOI line is not asserted when the EOS character
sent during a write operation.
non-zero = The EOI line is asserted when the EOS character
sent during a write operation.
See ibeos .

IbaEOT zero = The GPIB EOI line is not asserted at the end of a writ
operation.
non-zero = EOI is asserted at the end of a write.
See ibeot .

IbaHSCableLength 0 = High-speed (HS488) data transfer is disabled.
1 to 15 = High-speed (HS488) data transfer is enabled. 
The number returned represents the number of meters of 
GPIB cable in your system.

Refer to the NI-488.2 online help for information about 
high-speed (HS488) data transfer. To view the online help, 
select Start» Programs»National Instruments NI-488.2» 
Explore GPIB and select the Measurement & Automation 
icon. Then, select a GPIB interface under Devices and 
Interfaces, right-click, and choose NI-488.2 Help.

IbaIst The individual status (ist ) bit of the interface.

IbaPAD The current primary address of the interface. See ibpad .

IbaPP2 zero = The interface is in PP1 mode—remote parallel poll 
configuration.
non-zero = The interface is in PP2 mode—local parallel poll
configuration.

Refer to the NI-488.2 online help for more information about
parallel polls. To view the online help, select Start» 
Programs»National Instruments NI-488.2»Explore GPIB 
and select the Measurement & Automation icon. Then, select 
a GPIB interface under Devices and Interfaces, right-click, 
and choose NI-488.2 Help.

IbaPPC The current parallel poll configuration information of the 
interface. See ibppc .

Table 1-3.  ibask  Board Configuration Parameter Options (Continued)

Options (Constants) Returned Information
NI-488.2 Function Reference Manual for Windows 1-8 © National Instruments Corporation
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IbaPPollTime 0 = The interface uses the standard duration (2 µs) when 
conducting a parallel poll.
1 to 17 = The interface uses a variable length duration when
conducting a parallel poll. The duration values correspond to
the ibtmo  timing values.

IbaReadAdjust 0 = Read operations do not have pairs of bytes swapped.
1 = Read operations have each pair of bytes swapped.

IbaRsv The current serial poll status byte of the interface.

IbaSAD The current secondary address of the interface. See ibsad .

IbaSC zero = The interface is not the GPIB System Controller.
non-zero = The interface is the System Controller.
See ibrsc .

IbaSendLLO zero = The GPIB LLO command is not sent when a device i
put online—ibfind  or ibdev .
non-zero = The LLO command is sent.

IbaSRE zero = The interface does not automatically assert the 
GPIB REN line when it becomes the System Controller.
non-zero = The interface automatically asserts REN when it
becomes the System Controller.
See ibrsc  and ibsre .

IbaTIMING The current bus timing of the interface.
1 = Normal timing (T1 delay of 2 µs).
2 = High speed timing (T1 delay of 500 ns).
3 = Very high speed timing (T1 delay of 350 ns).

IbaTMO The current timeout period of the interface. See ibtmo .

IbaWriteAdjust 0 = Write operations do not have pairs of bytes swapped.
1 = Write operations have each pair of bytes swapped.

Table 1-3.  ibask  Board Configuration Parameter Options (Continued)

Options (Constants) Returned Information
© National Instruments Corporation 1-9 NI-488.2 Function Reference Manual for Windows
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Table 1-4 lists the options you can use with ibask  when ud is a device descriptor or a device
index.

Table 1-4.  ibask  Device Configuration Parameter Options

Options (Constants) Returned Information

IbaBNA The index of the GPIB access interface used by the given 
device descriptor.

IbaEOSchar The current EOS character of the device. See ibeos .

IbaEOScmp zero = A 7-bit compare is used for all EOS comparisons.
non-zero = An 8-bit compare is used for all EOS comparison
See ibeos .

IbaEOSrd zero = The EOS character is ignored during read operations
non-zero = Read operation will be terminated by the EOS 
character. See ibeos .

IbaEOSwrt zero = The EOI line is not asserted when the EOS character
sent during a write operation.
non-zero = The EOI line is asserted when the EOS character
sent during a write. See ibeos .

IbaEOT zero = The GPIB EOI line is not asserted at the end of a writ
operation.
non-zero = EOI is asserted at the end of a write.
See ibeot .

IbaPAD The current primary address of the device. See ibpad .

IbaReadAdjust 0 = Read operations do not have pairs of bytes swapped.
1 = Read operations have each pair of bytes swapped.

IbaREADDR zero = No unnecessary addressing is performed between 
device-level read and write operations.
non-zero = Addressing is always performed before a 
device-level read or write operation.

IbaSAD The current secondary address of the device. See ibsad .

IbaSPollTime The length of time the driver waits for a serial poll response 
when polling the device. The length of time is represented b
the ibtmo  timing values.

IbaTMO The current timeout period of the device. See ibtmo .
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IbaUnAddr zero = The GPIB commands Untalk (UNT) and Unlisten 
(UNL) are not sent after each device-level read and write 
operation.
non-zero = The UNT and UNL commands are sent after eac
device-level read and write.

IbaWriteAdjust 0 = Write operations do not have pairs of bytes swapped.
1 = Write operations have each pair of bytes swapped.

Table 1-4.  ibask  Device Configuration Parameter Options (Continued)

Options (Constants) Returned Information
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IBBNA
Device Level

Purpose
Change the access interface of a device.

Format
C
int ibbna (int ud, char *bname)

Visual Basic
CALL ibbna (ud%, bname$)

or

status% = ilbna (ud%, bname$)

Input
ud A device unit descriptor
bname An access interface name such as GPIB0

Output
Function Return The value of ibsta

Description
ibbna  assigns the device described by ud to the access interface described by bname. All 
subsequent bus activity with device ud occurs through the access interface bname. If the call 
succeeds, iberr  contains the previous access interface index.

Possible Errors
EARG Either ud does not refer to a device or bname does not refer to a valid interface

name.
ECIC The access interface is not Controller-In-Charge. Refer to the NI-488.2 online 

help for more information. To view the online help, select Start»Programs» 
National Instruments NI-488.2»Explore GPIB and select the Measurement 
& Automation  icon. Then, select a GPIB interface under Devices and 
Interfaces, right-click, and choose NI-488.2 Help.

EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The access interface is not installed or configured properly.
EOIP Asynchronous I/O is in progress.
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IBCAC
Board Level

Purpose
Become Active Controller.

Format
C
int ibcac (int ud, int v)

Visual Basic
CALL ibcac (ud%, v%)

or

status% = ilcac (ud%, v%)

Input
ud An interface unit descriptor
v Determines if control is to be taken asynchronously or 

synchronously

Output
Function Return The value of ibsta

Description
Using ibcac , the designated GPIB interface attempts to become the Active Controller b
asserting ATN. If v  is zero, the GPIB interface takes control asynchronously; if v  is non-zero, 
the GPIB interface takes control synchronously. Before you call ibcac , the GPIB interface 
must already be CIC. To make the interface CIC, use the ibsic  function.

To take control synchronously, the GPIB interface attempts to assert the ATN signal wi
corrupting transferred data. If this is not possible, the interface takes control asynchron

To take control asynchronously, the GPIB interface asserts ATN immediately without re
for any data transfer currently in progress.

Most applications do not need to use ibcac . Functions that require ATN to be asserted, suc
as ibcmd , do so automatically.
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Possible Errors
EARG ud is valid but does not refer to an interface.
ECIC The interface is not Controller-In-Charge. Refer to the NI-488.2 online help for 

more information. To view the online help, select Start»Programs»National 
Instruments NI-488.2»Explore GPIB and select the Measurement & 
Automation icon. Then, select a GPIB interface under Devices and Interfaces, 
right-click, and choose NI-488.2 Help.

EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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IBCLR
Device Level

Purpose
Clear a specific device.

Format
C
int ibclr (int ud)

Visual Basic
CALL ibclr (ud%)  

or 

status% = ilclr (ud%)

Input
ud A device unit descriptor

Output
Function Return The value of ibsta

Description
ibclr  sends the GPIB Selected Device Clear (SDC) message to the device describedud.

Possible Errors
EARG ud is a valid descriptor but does not refer to a device.
EBUS No devices are connected to the GPIB.
ECIC The access interface is not Controller-In-Charge. Refer to the NI-488.2 online 

help for more information. To view the online help, select Start»Programs» 
National Instruments NI-488.2»Explore GPIB and select the Measurement 
& Automation  icon. Then, select a GPIB interface under Devices and 
Interfaces, right-click, and choose NI-488.2 Help.

EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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IBCMD
Board Level

Purpose
Send GPIB commands.

Format
C
int ibcmd (int ud, void *cmdbuf, long count)

Visual Basic
CALL ibcmd (ud%, cmdbuf$)

or

status% = ilcmd (ud%, cmdbuf$, count&)

Input
ud An interface unit descriptor
cmdbuf Buffer of command bytes to send
count Number of command bytes to send

Output
Function Return The value of ibsta

Description
ibcmd  sends count  bytes from cmdbuf  over the GPIB as command bytes (interface 
messages). The number of command bytes transferred is returned in the global variab
ibcntl . Refer to Appendix A, Multiline Interface Messages, for a table of the defined 
interface messages.

Command bytes are used to configure the state of the GPIB. They are not used to sen
instructions to GPIB devices. Use ibwrt  to send device-specific instructions.
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Possible Errors
EABO The timeout period expired before all of the command bytes were sent.
EARG ud is valid but does not refer to an interface.
ECIC The interface is not Controller-In-Charge.Refer to the NI-488.2 online help for 

more information. To view the online help, select Start»Programs»National 
Instruments NI-488.2»Explore GPIB and select the Measurement & 
Automation icon. Then, select a GPIB interface under Devices and Interfaces, 
right-click, and choose NI-488.2 Help.

EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
ENOL No Listeners are on the GPIB.
EOIP Asynchronous I/O is in progress.
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IBCMDA
Board Level

Purpose
Send GPIB commands asynchronously.

Format
C
int ibcmda (int ud, void *cmdbuf, long count)

Visual Basic
CALL ibcmda (ud%, cmdbuf$)

or

status% = ilcmda (ud%, cmdbuf$, count&)

Input
ud An interface unit descriptor
cmdbuf Buffer of command bytes to send
count Number of command bytes to send

Output
Function Return The value of ibsta

Description
ibcmda  sends count  bytes from cmdbuf  over the GPIB as command bytes (interface 
messages). The number of command bytes transferred is returned in the global variab
ibcntl . Refer to Appendix A, Multiline Interface Messages, for a table of the defined 
interface messages.

Command bytes are used to configure the state of the GPIB. They are not used to sen
instructions to GPIB devices. Use ibwrt  to send device-specific instructions.

The asynchronous I/O calls (ibcmda , ibrda , ibwrta ) are designed so that applications ca
perform other non-GPIB operations while the I/O is in progress. Once the asynchronou
begins, further NI-488.2 calls are strictly limited. Any calls that would interfere with the 
in progress are not allowed; the driver returns EOIP in this case.
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Once the I/O is complete, the application must resynchronize with the NI-488.2 driver. 
Resynchronization is accomplished by using one of the following functions:
ibnotify If the ibsta  value passed to the ibnotify  callback contains 

CMPL, the driver and application are resynchronized.
ibwait If the returned ibsta  contains CMPL, the driver and application

are resynchronized.
ibstop The I/O is canceled; the driver and application are resynchroniz
ibonl The I/O is canceled and the interface is reset; the driver and 

application are resynchronized.

Possible Errors
EARG ud is valid but does not refer to an interface.
ECIC The interface is not Controller-In-Charge. Refer to the NI-488.2 online help for 

more information. To view the online help, select Start»Programs»National 
Instruments NI-488.2»Explore GPIB and select the Measurement & 
Automation icon. Then, select a GPIB interface under Devices and Interfaces, 
right-click, and choose NI-488.2 Help.

EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
ENOL No Listeners are on the GPIB.
EOIP Asynchronous I/O is in progress.
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IBCONFIG
Board Level/Device Level

Purpose
Change the software configuration parameters.

Format
C
ibconfig (int ud, int option, int value)

Visual Basic
CALL ibconfig (ud%, option%, value%)

or

status% = ilconfig (ud%, option%, value%)

Input
ud Interface or device unit descriptor
option A parameter that selects the software configuration item
value The value to which the selected configuration item is to be 

changed

Output
Function Return The value of ibsta

Description
ibconfig  changes a configuration item to the specified value for the selected interface
device. option  can be any of the defined constants in Table 1-5 and value  must be valid for 
the parameter that you are configuring. The previous setting of the configured item is ret
in iberr .

Possible Errors
EARG Either option  or value  is not valid. Table 1-5 lists the valid options.
ECAP The driver is not able to make the requested change.
EDVR Either ud is invalid or the NI-488.2 driver is not installed.
EOIP Asynchronous I/O is in progress.
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Table 1-5 lists the options you can use with ibconfig  when ud is an interface descriptor or 
an interface index.

Table 1-5.  ibconfig  Board Configuration Parameter Options

Options (Constants) Values

IbcAUTOPOLL zero = Disable automatic serial polling.
non-zero = Enable automatic serial polling.
Default determined by the NI-488.2 Configuration utility.

Refer to the NI-488.2 online help for more information about
automatic serial polling. To view the online help, select Start» 
Programs»National Instruments NI-488.2»Explore GPIB 
and select the Measurement & Automation icon. Then, select 
a GPIB interface under Devices and Interfaces, right-click, 
and choose NI-488.2 Help.

IbcCICPROT zero = Disable the CIC protocol.
non-zero = Enable the CIC protocol.
Default determined by the NI-488.2 Configuration utility.

Refer to the NI-488.2 online help for more information about
the CIC protocol. To view the online help, select Start» 
Programs»National Instruments NI-488.2»Explore GPIB 
and select the Measurement & Automation icon. Then, select 
a GPIB interface under Devices and Interfaces, right-click, 
and choose NI-488.2 Help.

IbcDMA Identical to ibdma .
Default determined by the NI-488.2 Configuration utility.

IbcEndBitIsNormal zero = Do not set the END bit of ibsta  when an EOS match 
occurs during a read.
non-zero = Set the END bit of ibsta  when an EOS match 
occurs during a read.
Default: non-zero.

IbcEOSchar Any 8-bit value. This byte becomes the new EOS character.
Default determined by the NI-488.2 Configuration utility.

IbcEOScmp zero = Use 7 bits for the EOS character comparison.
non-zero = Use 8 bits for the EOS character comparison.
Default determined by the NI-488.2 Configuration utility.

IbcEOSrd zero = Ignore EOS character during read operations.
non-zero = Terminate reads when the EOS character is read
Default determined by the NI-488.2 Configuration utility.
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IbcEOSwrt zero = Do not assert EOI with the EOS character during writ
operations.
non-zero = Assert EOI with the EOS character during write 
operations.
Default determined by the NI-488.2 Configuration utility.

IbcEOT Changes the data termination mode for write operations. 
Identical to ibeot .
Default determined by the NI-488.2 Configuration utility.

IbcHSCableLength 0 = High-speed (HS488) data transfer is disabled.
1 to 15 = The number of meters of GPIB cable in your system
The NI-488.2 software uses this information to select the 
appropriate high-speed (HS488) data transfer mode. Defaul
determined by the NI-488.2 Configuration utility.

Refer to the NI-488.2 online help for information about 
high-speed (HS488) data transfer. To view the online help, 
select Start»Programs»National Instruments NI-488.2» 
Explore GPIB and select the Measurement & Automation 
icon. Then, select a GPIB interface under Devices and 
Interfaces, right-click, and choose NI-488.2 Help.

IbcIst Changes the individual status (ist ) bit of the interface. 
Identical to ibist .
Default: zero

IbcPAD Changes the primary address of the interface. Identical to 
ibpad .
Default determined by the NI-488.2 Configuration utility.

IbcPP2 zero = PP1 mode.
non-zero = PP2 mode.
Default: zero.

Refer to the NI-488.2 online help for more information about
parallel polling. To view the online help, select Start» 
Programs»National Instruments NI-488.2»Explore GPIB 
and select the Measurement & Automation icon. Then, select 
a GPIB interface under Devices and Interfaces, right-click, 
and choose NI-488.2 Help.

Table 1-5.  ibconfig  Board Configuration Parameter Options (Continued)

Options (Constants) Values
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IbcPPC Configures the interface for parallel polls. Identical to 
board-level ibppc . 
Default: zero.

IbcPPollTime 0 = Use the standard duration (2 µs) when conducting a 
parallel poll.
1 to 17 = Use a variable length duration when conducting a 
parallel poll. The duration represented by 1 to 17 correspond
to the ibtmo  values.
Default: zero.

IbcReadAdjust 0 = No byte swapping.
1 = Swap pairs of bytes during a read.
Default: zero.

IbcRsv Changes the serial poll status byte of the interface. Identical 
ibrsv .
Default: zero.

IbcSAD Changes the secondary address of the interface. Identical to
ibsad .
Default determined by the NI-488.2 Configuration utility.

IbcSC Request or release system control. Identical to ibrsc .
Default determined by the NI-488.2 Configuration utility.

IbcSendLLO zero = Do not send LLO when putting a device 
online—ibfind  or ibdev .
non-zero = Send LLO when putting a device online—
ibfind  or ibdev .
Default: zero.

IbcSRE Assert the Remote Enable (REN) line. Identical to ibsre .
Default: zero.

IbcTIMING 1 = Normal timing (T1 delay of 2 µs).
2 = High-speed timing (T1 delay of 500 ns).
3 = Very high-speed timing (T1 delay of 350 ns).
Default determined by the NI-488.2 Configuration utility.
The T1 delay is the GPIB Source Handshake timing.

Table 1-5.  ibconfig  Board Configuration Parameter Options (Continued)

Options (Constants) Values
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Table 1-6 lists the options you can use with ibconfig  when ud is a device descriptor or a 
device index.

IbcTMO Changes the timeout period of the interface. Identical to 
ibtmo .
Default determined by the NI-488.2 Configuration utility.

IbcWriteAdjust 0 = No byte swapping.
1 = Swap pairs of bytes during a write.
Default: zero.

Table 1-6.  ibconfig  Device Configuration Parameter Options

Options (Constants) Legal Values

IbcEOSchar Any 8-bit value. This byte becomes the new EOS character.
Default determined by the NI-488.2 Configuration utility.

IbcEOScmp zero = Use seven bits for the EOS character comparison.
non-zero = Use eight bits for the EOS character comparison
Default determined by the NI-488.2 Configuration utility.

IbcEOSrd zero = Ignore EOS character during read operations.
non-zero = Terminate reads when the EOS character is read
Default determined by the NI-488.2 Configuration utility.

IbcEOSwrt zero = Do not send EOI with the EOS character during write
operations.
non-zero = Send EOI with the EOS character during writes.
Default determined by the NI-488.2 Configuration utility.

IbcEOT Changes the data termination method for writes. Identical to
ibeot .
Default determined by the NI-488.2 Configuration utility.

IbcPAD Changes the primary address of the device. Identical to ibpad .
Default determined by the NI-488.2 Configuration utility.

IbcReadAdjust 0 = No byte swapping.
1 = Swap pairs of bytes during a read.
Default: zero.

Table 1-5.  ibconfig  Board Configuration Parameter Options (Continued)

Options (Constants) Values
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IbcREADDR zero = No unnecessary readdressing is performed between
device-level reads and writes.
non-zero = Addressing is always performed before a 
device-level read or write.
Default determined by the NI-488.2 Configuration utility.

IbcSAD Changes the secondary address of the device. Identical to 
ibsad .
Default determined by the NI-488.2 Configuration utility.

IbcSPollTime 0 to 17 = Sets the length of time the driver waits for a serial po
response byte when polling the given device. The length of 
time represented by 0 to 17 corresponds to the ibtmo  values.
Default: 11.

IbcTMO Changes the device timeout period. Identical to ibtmo .
Default determined by the NI-488.2 Configuration utility.

IbcUnAddr zero = Do not send Untalk (UNT) and Unlisten (UNL) at the 
end of device-level reads and writes.
non-zero = Send UNT and UNL at the end of device-level 
reads and writes.
Default: zero.

IbcWriteAdjust 0 = No byte swapping.
1 = Swap pairs of bytes during a write.
Default: zero.

Table 1-6.  ibconfig  Device Configuration Parameter Options (Continued)

Options (Constants) Legal Values
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IBDEV
Device Level

Purpose
Open and initialize a device descriptor.

Format
C
int ibdev (int BdIndx, int pad, int sad, int tmo, int eot, int eos)

Visual Basic
CALL ibdev (BdIndx%, pad%, sad%, tmo%, eot%, eos%, ud%)

or

ud% = ildev (BdIndx%, pad%, sad%, tmo%, eot%, eos%)

Input
BdIndx Index of the access interface for the device
pad The primary GPIB address of the device
sad The secondary GPIB address of the device
tmo The I/O timeout value
eot EOI mode of the device
eos EOS character and modes

Output
Function Return The device descriptor or a –1

Description
ibdev  acquires a device descriptor to use in subsequent device-level traditional NI-488
calls. It opens and initializes a device descriptor and configures it according to the inpu
parameters.

For more details on the meaning and effect of each input parameter, see the correspon
NI-488.2 calls for ibbna , ibpad , ibsad , ibtmo , ibeot , and ibeos .
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If ibdev  is unable to get a valid device descriptor, a –1 is returned; the ERR bit is set in ibsta  
and iberr  contains EDVR.

Note Unit descriptors are allocated on a per process basis, so it is not possible to 
share them between processes. If you pass a unit descriptor from one process to a 
process, all NI-488.2 calls using that descriptor in the second process will return ED

Possible Errors
EARG pad , sad , tmo , eot , or eos  is invalid. See ibpad , ibsad , ibtmo , ibeot , and 

ibeos  for details on setting these parameters.
EDVR Either no device descriptors are available or BdIndx  refers to a GPIB interface 

that is not installed.
ENEB The interface is not installed or is not properly configured.
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IBDMA
Board Level

Purpose
Enable or disable DMA.

Format
C
int ibdma (int ud, int v)

Visual Basic
CALL ibdma (ud%, v%)

or 

status% = ildma (ud%, v%)

Input
ud Interface descriptor
v Enable or disable the use of DMA

Output
Function Return The value of ibsta

Description
ibdma  enables or disables DMA transfers for the interface, according to v. If v  is zero, DMA 
is not used for GPIB I/O transfers. If v  is non-zero, DMA is used for GPIB I/O transfers.

Possible Errors
EARG ud is valid but does not refer to an interface.
ECAP The interface is not configured to use a DMA channel. Use the NI-488.2 

Configuration utility to configure a DMA channel.
EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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IBEOS
Board Level/Device Level

Purpose
Configure the end-of-string (EOS) termination mode or character.

Format
C
int ibeos (int ud, int v)

Visual Basic
CALL ibeos (ud%, v%)

or 

status% = ileos (ud%, v%)

Input
ud Interface or device descriptor
v EOS mode and character information

Output
Function Return The value of ibsta

Description
ibeos  configures the EOS termination mode or EOS character for the interface or dev
The parameter v  describes the new end-of-string (EOS) configuration to use. If v  is zero, the 
EOS configuration is disabled. Otherwise, the low byte is the EOS character and the u
byte contains flags which define the EOS mode. 

Note Defining an EOS byte does not cause the driver to automatically send that byte 
end of write I/O operations. Your application is responsible for placing the EOS byte a
end of the data strings that it defines.
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Table 1-7 describes the different EOS configurations and the corresponding values of v. If no 
error occurs during the call, the value of the previous EOS setting is returned in iberr .

Configuration bits A and C determine how to terminate read I/O operations. If bit A is set
bit C is clear, a read ends when a byte that matches the low seven bits of the EOS char
received. If bits A and C are both set, a read ends when a byte that matches all eight b
the EOS character is received.

Configuration bits B and C determine when a write I/O operation asserts the GPIB EOI
If bit B is set and bit C is clear, EOI is asserted when the written character matches the
seven bits of the EOS character. If bits B and C are both set, EOI is asserted when the 
character matches all eight bits of the EOS character.

For more information about the termination of I/O operations, refer to the NI-488.2 onli
help. To view the online help, select Start»Programs»National Instruments NI-488.2» 
Explore GPIB and select the Measurement & Automation icon.Then, select a GPIB 
interface under Devices and Interfaces, right-click, and choose NI-488.2 Help.

Examples
ibeos (ud, 0x140A); /* Configure the software to end reads on

newline character (hex 0A) for the unit

descriptor, ud */

ibeos (ud, 0x180A); /* Configure the software to assert the GPIB

EOI line whenever the newline character

(hex 0A) is written out by the unit 

descriptor, ud */

Possible Errors
EARG The high byte of v  contains invalid bits.
EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.

Table 1-7.  EOS Configurations

Bit Configuration

Value of v

High Byte Low Byte

A Terminate read when EOS is detected 00000100 EOS character

B Set EOI with EOS on write function 00001000 EOS character

C Compare all 8 bits of EOS byte rather than 
low 7 bits (all read and write functions)

00010000 EOS character
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IBEOT
Board Level/Device Level

Purpose
Enable or disable the automatic assertion of the GPIB EOI line at the end of write I/O 
operations.

Format
C
int ibeot (int ud, int v)

Visual Basic
CALL ibeot (ud%, v%)  

or 

status% = ileot (ud%, v%)

Input
ud Interface or device descriptor
v Enables or disables the end of transmission assertion of EOI

Output
Function Return The value of ibsta

Description
ibeot  enables or disables the assertion of the EOI line at the end of write I/O operation
the interface or device described by ud. If v  is non-zero, EOI is asserted when the last byte 
a GPIB write is sent. If v  is zero, nothing occurs when the last byte is sent. If no error occ
during the call, the previous value of EOT is returned in iberr .

For more information about the termination of I/O operations, refer to the NI-488.2 onli
help. To view the online help, select Start»Programs»National Instruments NI-488.2» 
Explore GPIB and select the Measurement & Automation icon. Then, select a GPIB 
interface under Devices and Interfaces, right-click, and choose NI-488.2 Help.

Possible Errors
EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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IBFIND
Board Level/Device Level

Purpose
Open and initialize an interface or a user-configured device descriptor.

Format
C
int ibfind (char *udname)

Visual Basic
CALL ibfind (udname$, ud%)

or

ud% = ilfind (udname$)

Input
udname A user-configured device or interface name

Output
Function Return The interface or device descriptor, or a –1

Description
ibfind  is used to acquire a descriptor for an interface or user-configured device; this 
interface or device descriptor can be used in subsequent traditional NI-488.2 calls.

ibfind  performs the equivalent of an ibonl  1 to initialize the interface or device descriptor
The unit descriptor returned by ibfind  remains valid until the interface or device is put 
offline using ibonl  0.

If ibfind  is unable to get a valid descriptor, a –1 is returned; the ERR bit is set in ibsta  and 
iberr  contains EDVR.

Note Unit descriptors are allocated on a per process basis, so it is not possible to 
share them between processes. If you pass a unit descriptor from one process to a 
process, all NI-488.2 calls using that descriptor in the second process will return ED

Note Using ibfind  to obtain device descriptors is useful only for compatibility with 
existing applications. New applications should use ibdev  instead of ibfind . ibdev  is 
more flexible, easier to use, and frees the application from unnecessary device nam
requirements.
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8.2 
Possible Errors
EBUS Device level: No devices are connected to the GPIB.
ECIC Device level: The access interface is not Controller-In-Charge. Refer to th 

NI-488.2 online help for more information. To view the online help, select 
Start»Programs»National Instruments NI-488.2»Explore GPIB and select 
the Measurement & Automation icon. Then, select a GPIB interface under 
Devices and Interfaces, right-click, and choose NI-488.2 Help.

EDVR Either udname is not recognized as an interface or device name or the NI-48
driver is not installed.

ENEB The interface is not installed or is not properly configured.
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IBGTS
Board Level

Purpose
Go from Active Controller to Standby.

Format
C
int ibgts (int ud, int v)

Visual Basic
CALL ibgts (ud%, v%)  

or

status% = ilgts (ud%, v%)

Input
ud Interface descriptor
v Determines whether to perform acceptor handshaking

Output
Function Return The value of ibsta

Description
ibgts  causes the GPIB interface at ud to go to Standby Controller and the GPIB ATN line t
be unasserted. If v  is non-zero, acceptor handshaking or shadow handshaking is perform
until END occurs or until ATN is reasserted by a subsequent ibcac  call. With this option, the 
GPIB interface can participate in data handshake as an acceptor without actually readin
If END is detected, the interface enters a Not Ready For Data (NRFD) handshake hold
state which results in hold off of subsequent GPIB transfers. If v  is 0, no acceptor handshaking
or holdoff is performed.

Before performing an ibgts  with shadow handshake, call the ibeos  function to establish 
proper EOS modes.

For details on the IEEE-488.1 handshake protocol, refer to the ANSI/IEEE 
Standard 488.1-1987, IEEE Standard Digital Interface for Programmable Instrumentation.
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Possible Errors

EADR v  is non-zero, and either ATN is low or the interface is a Talker or a Listen
EARG ud is valid but does not refer to an interface.
ECIC The interface is not Controller-In-Charge. Refer to the NI-488.2 online help for 

more information. To view the online help, select Start»Programs»National 
Instruments NI-488.2»Explore GPIB and select the Measurement & 
Automation icon. Then, select a GPIB interface under Devices and Interfaces, 
right-click, and choose NI-488.2 Help.

EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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IBIST
Board Level

Purpose
Set or clear the interface individual status bit for parallel polls.

Format
C
int ibist (int ud, int v)

Visual Basic
CALL ibist (ud%, v%)  

or

status% = ilist (ud%, v%)

Input
ud Interface descriptor
v Indicates whether to set or clear the ist  bit

Output
Function Return The value of ibsta

Description
ibist  sets the interface ist  (individual status) bit according to v. If v  is zero, the ist  bit is 
cleared; if v  is non-zero, the ist  bit is set. The previous value of the ist  bit is returned in 
iberr .

For more information about parallel polling, refer to the NI-488.2 online help. To view th
online help, select Start»Programs»National Instruments NI-488.2»Explore GPIB and 
select the Measurement & Automation icon. Then, select a GPIB interface under Devices 
and Interfaces, right-click, and choose NI-488.2 Help.

Possible Errors
EARG ud is valid but does not refer to an interface.
EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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IBLINES
Board Level

Purpose
Return the status of the eight GPIB control lines.

Format
C
int iblines (int ud, short *clines)

Visual Basic
CALL iblines (ud%, clines%)

or

status% = illines (ud%, clines%)

Input
ud Interface descriptor

Output
clines Returns GPIB control line state information
Function Return The value of ibsta

Description
iblines  returns the state of the GPIB control lines in clines . The low-order byte (bits 0 
through 7) of clines  contains a mask indicating the capability of the GPIB interface to se
the status of each GPIB control line. The upper byte (bits 8 through 15) contains the G
control line state information. The following is a pattern of each byte.

To determine if a GPIB control line is asserted, first check the appropriate bit in the lower
to determine if the line can be monitored. If the line can be monitored (indicated by a 1 i
appropriate bit position), check the corresponding bit in the upper byte. If the bit is set (1
corresponding control line is asserted. If the bit is clear (0), the control line is unasserte

7 6 5 4 3 2 1 0

EOI ATN SRQ REN IFC NRFD NDAC DAV
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Example
short lines;

iblines (ud, &lines);

if (lines & ValidREN) {  /* check to see if REN is asserted */

if (lines & BusREN) {

printf ("REN is asserted");

}

}

Possible Errors
EARG ud is valid but does not refer to an interface.
EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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IBLN
Board Level/Device Level

Purpose
Check for the presence of a device on the bus.

Format
C
int ibln (int ud, int pad, int sad, short *listen)

Visual Basic
CALL ibln (ud%, pad%, sad%, listen%)

or

status% = illn (ud%, pad%, sad%, listen%)

Input
ud Interface or device descriptor
pad The primary GPIB address of the device
sad The secondary GPIB address of the device

Output
listen Indicates if a device is present or not
Function Return The value of ibsta

Description
ibln  determines whether there is a listening device at the GPIB address designated b
pad  and sad  parameters. If ud is an interface descriptor, the bus associated with that interf
is tested for Listeners. If ud is a device descriptor, ibln  uses the access interface associate
with that device to test for Listeners. If a Listener is detected, a non-zero value is return
listen . If no Listener is found, zero is returned.

The pad  parameter can be any valid primary address (a value between 0 and 30). The sad  
parameter can be any valid secondary address (a value between 96 to 126), or one of
constants NO_SAD or ALL_SAD. The constant NO_SAD designates that no secondary address
to be tested (only a primary address is tested). The constant ALL_SAD designates that all 
secondary addresses are to be tested.
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Possible Errors
EARG Either the pad  or sad  argument is invalid.
ECIC Device level: The access interface is not Controller-In-Charge. Refer to th 

NI-488.2 online help for more information. To view the online help, select 
Start»Programs»National Instruments NI-488.2»Explore GPIB and select 
the Measurement & Automation icon. Then, select a GPIB interface under 
Devices and Interfaces, right-click, and choose NI-488.2 Help.

EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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Board Level/Device Level

Purpose
Go to Local.

Format
C
int ibloc (int ud)

Visual Basic
CALL ibloc (ud%)

or

status% = illoc (ud%)

Input
ud Interface or device descriptor

Output
Function Return The value of ibsta

Description
Board Level
ibloc  places the interface in local mode if it is not in a lockout state. The interface is in
lockout state if LOK does not appear in the status word ibsta . If the interface is in a lockout 
state, the call has no effect.

The ibloc  function is used to simulate a front panel RTL (Return to Local) switch if the
computer is used as an instrument.

Device Level
Unless the REN (Remote Enable) line has been unasserted with the ibsre  function, all 
device-level functions automatically place the specified device in remote program mod
ibloc  is used to move devices temporarily from a remote program mode to a local mo
until the next device function is executed on that device.
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Possible Errors
EBUS Device level: No devices are connected to the GPIB.
ECIC Device level: The access interface is not Controller-In-Charge. Refer to th 

NI-488.2 online help for more information. To view the online help, select 
Start»Programs»National Instruments NI-488.2»Explore GPIB and select 
the Measurement & Automation icon. Then, select a GPIB interface under 
Devices and Interfaces, right-click, and choose NI-488.2 Help.

EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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IBNOTIFY
Board Level/Device Level

Purpose
Notify user of one or more GPIB events by invoking the user callback.

Format
C
int ibnotify (int ud, int mask, GpibNotifyCallback_t Callback, 

void * RefData)

Visual Basic
Not supported

Input
ud Interface or device descriptor
mask Bit mask of GPIB events to notice
Callback Pointer to the callback function (see prototype below)
RefData User-defined reference data for the callback

Output
Function Return The value of ibsta

Description
If mask is non-zero, ibnotify  monitors the events specified by mask, and when one or more
of the events is true, your Callback  is invoked. The ibnotify  mask bits are identical to the
ibsta  bits, and are defined in Table 1-8. For a board-level ibnotify  call, all mask bits are 
valid except for ERR and RQS. For a device-level ibnotify  call, the only valid mask bits 
are CMPL, TIMO, END, and RQS.

If TIMO is set in the notify mask, ibnotify  calls the callback function when the timeout 
period has elapsed, if one or more of the other specified events have not already occur
TIMO is not set in the notify mask, the callback is not called until one or more of the spec
events occur.
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Note Notification is performed when the state of one or more of the mask bits is true, 
a request is made to be notified when CMPL is true, and CMPL is currently true, the
Callback  is invoked immediately.

Note For device-level usage, notification on RQS cannot be guaranteed to work if 
automatic serial polling is disabled. By default, automatic serial polling is enabled.

A given ud can have only one outstanding ibnotify  call at any one time. If a current 
ibnotify  is in effect for ud, it is replaced by a subsequent ibnotify  call. An outstanding 
ibnotify  call for ud can be canceled by a subsequent ibnotify  call for ud that has a mask 
of 0.

If an ibnotify  call is outstanding and one or more of the GPIB events it is waiting on 
become true, the Callback  is invoked.

Table 1-8.  Notify Mask Layout

Mnemonic
Bit 

Position
Hex 

Value Description

TIMO 14 4000 Use the timeout period (see ibtmo ) to limit the notify period

END 13 2000 END or EOS is detected

SRQI 12 1000 SRQ is asserted (board-level only)

RQS 11 800 Device requested service (device-level only)

CMPL 8 100 I/O completed

LOK 7 80 GPIB interface is in Lockout State (board-level only)

REM 6 40 GPIB interface is in Remote State (board-level only)

CIC 5 20 GPIB interface is Controller-In-Charge (board-level only)

ATN 4 10 Attention is asserted (board-level only)

TACS 3 8 GPIB interface is Talker (board-level only)

LACS 2 4 GPIB interface is Listener (board-level only)

DTAS 1 2 GPIB interface is in Device Trigger State (board-level only)

DCAS 0 1 GPIB interface is in Device Clear State (board-level only)
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Callback Prototype
int __stdcall Callback

               (int ud, int ibsta, int iberr, long ibcntl,

                void *RefData)

Callback Parameters
ud Interface or device descriptor
ibsta Value of ibsta

iberr Value of iberr

ibcntl Value of ibcntl

RefData User-defined reference data for the callback

Callback Return Value
Bit mask of the GPIB events to notice next.

The Callback  function executes in a separate thread in your process. Therefore, it has a
to any process global data, but no access to thread local data. If the Callback  needs to access
global data, you must protect that access using a synchronization primitive (for examp
semaphore) because the Callback  is running in a different thread context. Alternatively, th
issue of data protection can be avoided entirely if the Callback  simply posts a message to 
your application using the Windows PostMessage()  function. The Callback  function can 
call any of the NI-488.2 API with the exception of ibnotify . When the Callback  is 
invoked, the values of the GPIB global variables (ibsta , iberr , ibcntl ) are undefined. The 
status variables passed to Callback  should be examined, instead of the GPIB globals, to
determine why the Callback  was invoked. Notice that it is possible that the Callback  may 
be invoked because of an error condition rather than because of the setting of one or m
the requested mask bits.

The return value of the Callback  is interpreted as a mask value, which is used to 
automatically rearm the asynchronous event notification mechanism. If the return value
zero, it is not rearmed. If the return value is non-zero, the asynchronous event notificat
mechanism is rearmed with the return mask value. If the Callback  rearm fails due to an 
error, the Callback  is invoked with ibsta  set to ERR, iberr  set to EDVR, and ibcntl  set 
to IBNOTIFY_REARM_FAILED, which is defined in decl-32.h .

Like ibwait , ibstop , and ibonl , the invocation of the ibnotify  Callback  can cause the 
resynchronization of the handler after an asynchronous I/O operation has completed. I
case, the global variables passed into the Callback  after I/O has completed contain the statu
of the I/O operation.

For more information of the usage of ibnotify  and a detailed example, refer to the NI-488.
online help. To view the online help, select Start»Programs»National Instruments 
NI-488.2»Explore GPIB and select the Measurement & Automation icon. Then, select a 
GPIB interface under Devices and Interfaces, right-click, and choose NI-488.2 Help.
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Possible Errors for ibnotify
EARG A bit set in mask is invalid.
ECAP ibnotify  has been invoked from within an ibnotify Callback  function, 

or the handler cannot perform notification on one or more of the specified 
mask bits.

EDVR Either ud is invalid or the NI-488.2 driver is not installed. ibcntl  contains a 
system-dependent error code.

ENEB The interface is not installed or is not properly configured.

Possible Error for the Callback
EDVR The Callback  return failed to rearm the Callback .
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IBONL
Board Level/Device Level

Purpose
Place the device or interface online or offline.

Format
C
int ibonl (int ud, int v)

Visual Basic
CALL ibonl (ud%, v%)  

or

status% = ilonl (ud%, v%)

Input
ud Interface or device descriptor
v Indicates whether the interface or device is to be taken online

offline

Output
Function Return The value of ibsta

Description
ibonl  resets the interface or device and places all its software configuration paramete
in their pre-configured state. In addition, if v  is zero, the device or interface is taken offline
If v  is non-zero, the device or interface is left operational, or online.

If a device or an interface is taken offline, the interface or device descriptor (ud) is no longer 
valid. You must execute an ibdev  or ibfind  to access the interface or device again.

Possible Errors
EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
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IBPAD
Board Level/Device Level

Purpose
Change the primary address.

Format
C
int ibpad (int ud, int v)

Visual Basic
CALL ibpad (ud%, v%)  

or

status% = ilpad (ud%, v%)

Input
ud Interface or device descriptor
v GPIB primary address

Output
Function Return The value of ibsta

Description
ibpad  sets the primary GPIB address of the interface or device to v, an integer ranging from 
0 to 30. If no error occurs during the call, iberr  contains the previous GPIB primary addres

Possible Errors
EARG v  is not a valid primary GPIB address; it must be in the range 0 to 30.
EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
NI-488.2 Function Reference Manual for Windows 1-48 © National Instruments Corporation



Chapter 1 NI-488.2 API: Traditional Calls — IBPCT

 
tion 
IBPCT
Device Level

Purpose
Pass control to another GPIB device with Controller capability.

Format
C
int ibpct (int ud)

Visual Basic
CALL ibpct (ud%)  

or

status% = ilpct (ud%)

Input
ud Device descriptor

Output
Function Return The value of ibsta

Description
ibpct  passes Controller-in-Charge status to the device indicated by ud. The access interface
automatically unasserts the ATN line and goes to Controller Idle State (CIDS). This func
assumes that the device has Controller capability.

Possible Errors
EARG ud is valid but does not refer to a device.
EBUS No devices are connected to the GPIB.
ECIC The access interface is not Controller-In-Charge. Refer to the NI-488.2 online 

help for more information.To view the online help, select Start»Programs» 
National Instruments NI-488.2»Explore GPIB and select the Measurement 
& Automation  icon. Then, select a GPIB interface under Devices and 
Interfaces, right-click, and choose NI-488.2 Help.

EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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IBPPC
Board Level/Device Level

Purpose
Parallel poll configure.

Format
C
int ibppc (int ud, int v)

Visual Basic
CALL ibppc (ud%, v%)

or

status% = ilppc (ud%, v%)

Input
ud Interface or device descriptor
v Parallel poll enable/disable value

Output
Function Return The value of ibsta

Description
Device Level
If ud is a device descriptor, ibppc  enables or disables the device from responding to para
polls. The device is addressed and sent the appropriate parallel poll message—Paralle
Enable (PPE) or Disable (PPD). Valid parallel poll messages are 96 to 126 (hex 60 to he
or zero to send PPD.

Board Level
If ud is an interface descriptor, ibppc  performs a local parallel poll configuration using the
parallel poll configuration value v. Valid parallel poll messages are 96 to 126 (hex 60 to 
hex 7E) or zero to send PPD. If no error occurs during the call, iberr  contains the previous 
value of the local parallel poll configuration.
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For more information about parallel polling, refer to the NI-488.2 online help. To view th
online help, select Start»Programs»National Instruments NI-488.2»Explore GPIB and 
select the Measurement & Automation icon. Then, select a GPIB interface under Devices 
and Interfaces, right-click, and choose NI-488.2 Help.

Possible Errors
EARG v  does not contain a valid PPE or PPD message.
EBUS Device level: No devices are connected to the GPIB.
ECAP Board level: The interface is not configured to perform local parallel poll 

configuration. (See ibconfig , option IbcPP2 .)
ECIC Device level: The access interface is not Controller-In-Charge. Refer to th 

NI-488.2 online help for more information. To view the online help, select 
Start»Programs»National Instruments NI-488.2»Explore GPIB and select 
the Measurement & Automation icon. Then, select a GPIB interface under 
Devices and Interfaces, right-click, and choose NI-488.2 Help.

EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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IBRD
Board Level/Device Level

Purpose
Read data from a device into a user buffer.

Format
C
int ibrd (int ud, void *rdbuf, long count)

Visual Basic
CALL ibrd (ud%, rdbuf$)

or

status% = ilrd (ud%, rdbuf$, count&)

Input
ud Interface or device descriptor
count Number of bytes to be read from the GPIB

Output
rdbuf Address of buffer into which data is read
Function Return The value of ibsta

Description
Device Level
If ud is a device descriptor, ibrd  addresses the GPIB, reads up to count  bytes of data, and 
places the data into the buffer specified by rdbuf . The operation terminates normally when
count  bytes have been received or END is received. The operation terminates with an
if the transfer could not complete within the timeout period. The actual number of bytes
transferred is returned in the global variable ibcntl .

Board Level
If ud is an interface descriptor, ibrd  reads up to count  bytes of data and places the data int
the buffer specified by rdbuf . A board-level ibrd  assumes that the GPIB is already proper
addressed. The operation terminates normally when count  bytes have been received or END
is received. The operation terminates with an error if the transfer could not complete w
the timeout period or, if the interface is not CIC, the CIC sends a Device Clear on the G
The actual number of bytes transferred is returned in the global variable ibcntl .
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Possible Errors
EABO Either count  bytes or END was not received within the timeout period or a

Device Clear message was received after the read operation began.
EADR Board level: The GPIB is not correctly addressed; use ibcmd  to address 

the GPIB.
Device level: A conflict exists between the device GPIB address and the G
address of the device access interface. Use ibpad  and ibsad .

EBUS Device level: No devices are connected to the GPIB.
ECIC Device level: The access interface is not Controller-In-Charge. Refer to th 

NI-488.2 online help for more information. To view the online help, select 
Start»Programs»National Instruments NI-488.2»Explore GPIB and select 
the Measurement & Automation icon. Then, select a GPIB interface under 
Devices and Interfaces, right-click, and choose NI-488.2 Help.

EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
© National Instruments Corporation 1-53 NI-488.2 Function Reference Manual for Windows



Chapter 1 NI-488.2 API: Traditional Calls — IBRDA

 up 
d by 
s 

rface 
ytes 
IBRDA
Board Level/Device Level

Purpose
Read data asynchronously from a device into a user buffer.

Format
C
int ibrda (int ud, int *rdbuf, long count)

Visual Basic
CALL ibrda (ud%, rdbuf$)

or

status% = ilrda (ud%, rdbuf$, count&)

Input
ud Interface or device descriptor
count Number of bytes to be read from the GPIB

Output
rdbuf Address of buffer into which data is read
Function Return The value of ibsta

Description
Device Level
If ud is a device descriptor, ibrda  addresses the GPIB, begins an asynchronous read of
to count  bytes of data from a GPIB device, and places the data into the buffer specifie
rdbuf . The operation terminates normally when count  bytes have been received or END i
received. The actual number of bytes transferred is returned in the global variable ibcntl .

Board Level
If ud is an interface descriptor, ibrda  reads up to count  bytes of data from a GPIB device 
and places the data into the buffer specified by rdbuf . A board-level ibrda  assumes that the 
GPIB is already properly addressed. The operation terminates normally when count  bytes 
have been received or END is received. The operation terminates with an error if the inte
is not the CIC, and the CIC sends a Device Clear on the GPIB. The actual number of b
transferred is returned in the global variable ibcntl .
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Board and Device Level
The asynchronous I/O calls (ibcmda , ibrda , ibwrta ) are designed so that applications ca
perform other non-GPIB operations while the I/O is in progress. Once the asynchronou
has begun, further NI-488.2 calls are strictly limited. Any calls that would interfere with
I/O in progress are not allowed; the driver returns EOIP in this case.

Once the I/O is complete, the application must resynchronize with the NI-488.2 driver. 
Resynchronization is accomplished by using one of the following functions:
ibnotify If the ibsta  value passed to the ibnotify  callback contains 

CMPL, the driver and application are resynchronized.
ibwait If the returned ibsta  contains CMPL, the driver and application

are resynchronized.
ibstop The I/O is canceled; the driver and application are resynchroniz
ibonl The I/O is canceled and the interface is reset; the driver and 

application are resynchronized.

Possible Errors
EABO Board level: a Device Clear message was received from the CIC.
EADR Board level: The GPIB is not correctly addressed; use ibcmd  to address the 

GPIB.
Device level: A conflict exists between the device GPIB address and the G
address of the device access interface. Use ibpad  and ibsad .

EBUS Device level: No devices are connected to the GPIB.
ECIC Device level: The access interface is not Controller-In-Charge. Refer to th 

NI-488.2 online help for more information. To view the online help, select 
Start» Programs»National Instruments NI-488.2»Explore GPIB and select 
the Measurement & Automation icon. Then, select a GPIB interface under 
Devices and Interfaces, right-click, and choose NI-488.2 Help.

EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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IBRDF
Board Level/Device Level

Purpose
Read data from a device into a file.

Format
C
int ibrdf (int ud, char *flname)

Visual Basic
CALL ibrdf (ud%, flname$)

or

status% = ilrdf (ud%, flname$)

Input
ud Interface or device descriptor
flname Name of file into which data is read

Output
Function Return The value of ibsta

Description
Device Level
If ud is a device descriptor, ibrdf  addresses the GPIB, reads data from a GPIB device, 
places the data into the file specified by flname . The operation terminates normally when 
END is received. The operation terminates with an error if the transfer could not compl
within the timeout period. The actual number of bytes transferred is returned in the glo
variable ibcntl .

Board Level
If ud is an interface descriptor, ibrdf  reads data from a GPIB device and places the data i
the file specified by flname . A board-level ibrdf  assumes that the GPIB is already proper
addressed. The operation terminates normally when END is received. The operation 
terminates with an error if the transfer could not complete within the timeout period or,
the interface is not CIC, the CIC sends a Device Clear on the GPIB. The actual numbe
bytes transferred is returned in the global variable ibcntl .
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Possible Errors
EABO END was not received within the timeout period, or ud is an interface descriptor 

and Device Clear was received after the read operation began.
EADR Board level: The GPIB is not correctly addressed; use ibcmd  to address 

the GPIB.
Device level: A conflict exists between the device GPIB address and the G
address of the device access interface. Use ibpad  and ibsad .

EBUS Device level: No devices are connected to the GPIB.
ECIC Device level: The access interface is not Controller-In-Charge. Refer to th 

NI-488.2 online help for more information. To view the online help, select 
Start» Programs»National Instruments NI-488.2»Explore GPIB and select 
the Measurement & Automation icon. Then, select a GPIB interface under 
Devices and Interfaces, right-click, and choose NI-488.2 Help.

EDVR Either ud is invalid or the NI-488.2 driver is not installed.
EFSO ibrdf  could not access flname .
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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Board Level/Device Level

Purpose
Conduct a parallel poll.

Format
C
int ibrpp (int ud, char *ppr)

Visual Basic
CALL ibrpp (ud%, ppr%)  

or

status% = ilrpp (ud%, ppr%)

Input
ud Interface or device descriptor

Output
ppr Parallel poll response byte
Function Return The value of ibsta

Description
ibrpp  parallel polls all the devices on the GPIB. The result of this poll is returned in ppr .

For more information about parallel polling, refer to the NI-488.2 online help. To view th
online help, select Start»Programs»National Instruments NI-488.2»Explore GPIB and 
select the Measurement & Automation icon. Then, select a GPIB interface under Devices 
and Interfaces, right-click, and choose NI-488.2 Help.

Possible Errors
EBUS Device level: No devices are connected to the GPIB.
ECIC Device level: The access interface is not Controller-In-Charge. Refer to th 

NI-488.2 online help for more information. To view the online help, select 
Start»Programs»National Instruments NI-488.2»Explore GPIB and select 
the Measurement & Automation icon. Then, select a GPIB interface under 
Devices and Interfaces, right-click, and choose NI-488.2 Help.

EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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Board Level

Purpose
Request or release system control.

Format
C
int ibrsc (int ud, int v)

Visual Basic
CALL ibrsc (ud%, v%)  

or 

status% = ilrsc (ud%, v%)

Input
ud Interface descriptor
v Determines if system control is to be requested or released

Output
Function Return The value of ibsta

Description
ibrsc  requests or releases the capability to send Interface Clear (IFC) and Remote En
(REN) messages to devices. If v  is zero, the interface releases system control, and functio
requiring System Controller capability are not allowed. If v  is non-zero, functions requiring 
System Controller capability are subsequently allowed. If no error occurs during the ca
iberr  contains the previous System Controller state of the interface.

Possible Errors
EARG ud is a valid descriptor but does not refer to an interface.
EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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Device Level

Purpose
Conduct a serial poll.

Format
C
int ibrsp (int ud, char *spr)

Visual Basic
CALL ibrsp (ud%, spr%)  

or 

status% = ilrsp (ud%, spr%)

Input
ud Device descriptor

Output
spr Serial poll response byte
Function Return The value of ibsta

Description
The ibrsp  function is used to serial poll the device ud. The serial poll response byte is 
returned in spr . If bit 6 (hex 40) of the response is set, the device is requesting service.
When the automatic serial polling feature is enabled, the device might have already be
polled. In this case, ibrsp  returns the previously acquired status byte.

For more information about serial polling, refer to the NI-488.2 online help. To view the
online help, select Start»Programs»National Instruments NI-488.2»Explore GPIB and 
select the Measurement & Automation icon. Then, select a GPIB interface under Devices 
and Interfaces, right-click, and choose NI-488.2 Help.
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Possible Errors
EABO The serial poll response could not be read within the serial poll timeout pe
EARG ud is a valid descriptor but does not refer to a device.
EBUS No devices are connected to the GPIB.
ECIC The access interface is not Controller-In-Charge. Refer to the NI-488.2 online 

help for more information. To view the online help, select Start»Programs» 
National Instruments NI-488.2»Explore GPIB and select the Measurement 
& Automation  icon. Then, select a GPIB interface under Devices and 
Interfaces, right-click, and choose NI-488.2 Help.

EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
ESTB Autopolling is enabled and the serial poll queue of the device has overflow

Call ibrsp  more often to keep the queue from overflowing.
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Board Level

Purpose
Request service and change the serial poll status byte.

Format
C
int ibrsv (int ud, int v)

Visual Basic
CALL ibrsv (ud%, v%)

or

status% = ilrsv (ud%, v%)

Input
ud Interface descriptor
v Serial poll status byte

Output
Function Return The value of ibsta

Description
ibrsv  is used to request service from the Controller and to provide the Controller with 
application-dependent status byte when the Controller serial polls the GPIB interface.

The value v  is the status byte that the GPIB interface returns when serial polled by the 
Controller-In-Charge. If bit 6 (hex 40) is set in v, the GPIB interface requests service from th
Controller by asserting the GPIB SRQ line. When ibrsv  is called and an error does not occu
the previous status byte is returned in iberr .

Possible Errors
EARG ud is a valid descriptor but does not refer to an interface. 
EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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Board Level/Device Level

Purpose
Change or disable the secondary address.

Format
C
int ibsad (int ud, int v)

Visual Basic
CALL ibsad (ud%, v%)  

or

status% = ilsad (ud%, v%)

Input
ud Interface or device descriptor
v GPIB secondary address

Output
Function Return The value of ibsta

Description
ibsad  changes the secondary GPIB address of the given interface or device to v, an integer 
in the range 96 to 126 (hex 60 to hex 7E) or zero. If v  is zero, secondary addressing is disable
If no error occurs during the call, the previous value of the GPIB secondary address is re
in iberr .

Possible Errors
EARG v  is non-zero and outside the legal range 96 to 126.
EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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Board Level

Purpose
Assert interface clear.

Format
C
int ibsic (int ud)

Visual Basic
CALL ibsic (ud%)  

or

status% = ilsic (ud%)

Input
ud Interface descriptor

Output
Function Return The value of ibsta

Description
ibsic  asserts the GPIB interfaces clear (IFC) line for at least 100 µs if the GPIB interfa
System Controller. This initializes the GPIB and makes the interface CIC and Active 
Controller with ATN asserted.

The IFC signal resets only the GPIB interface functions of bus devices and not the inte
device functions. Consult your device documentation to determine how to reset the inte
functions of your device.

Possible Errors
EARG ud is a valid descriptor but does not refer to an interface.
EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
ESAC The interface does not have System Controller capability.
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Board Level

Purpose
Set or clear the Remote Enable (REN) line.

Format

C
int ibsre (int ud, int v)

Visual Basic
CALL ibsre (ud%, v%)  

or 

status% = ilsre (ud%, v%)

Input
ud Interface descriptor
v Indicates whether to set or clear the REN line

Output
Function Return The value of ibsta

Description
If v  is non-zero, the GPIB Remote Enable (REN) line is asserted. If v  is zero, REN is 
unasserted. The previous value of REN is returned in iberr .

REN is used by devices to choose between local and remote modes of operation. A de
should not actually enter remote mode until it receives its listen address.

Possible Errors
EARG ud is a valid descriptor but does not refer to an interface.
EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
ESAC The interface does not have System Controller capability.
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Board Level/Device Level

Purpose
Abort asynchronous I/O operation.

Format
C
int ibstop (int ud)

Visual Basic
CALL ibstop (ud%)  

or

status% = ilstop (ud%)

Input
ud Interface or device descriptor

Output
Function Return The value of ibsta

Description
The ibstop  function aborts any asynchronous read, write, or command operation that 
in progress and resynchronizes the application with the driver. If asynchronous I/O is in
progress, the error bit is set in the status word, ibsta , and EABO is returned, indicating 
that the I/O was successfully stopped.

Possible Errors
EABO Asynchronous I/O was successfully stopped.
EBUS Device level: No devices are connected to the GPIB.
EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
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Board Level/Device Level

Purpose
Change or disable the I/O timeout period.

Format
C
int ibtmo (int ud, int v)

Visual Basic
CALL ibtmo (ud%, v%)  

or

status% = iltmo (ud%, v%)

Input
ud Interface or device descriptor
v Timeout duration code

Output
Function Return The value of ibsta

Description
ibtmo  sets the timeout period of the interface or device to v. The timeout period is used to 
select the maximum duration allowed for a synchronous I/O operation (for example, ibrd  
and ibwrt ) or for an ibwait  or ibnotify  operation with TIMO in the wait mask. If the 
operation does not complete before the timeout period elapses, the operation is aborte
TIMO is returned in ibsta . See Table 1-9 for a list of valid timeout values. These timeou
values represent the minimum timeout period. The actual period could be longer.

Table 1-9.  Timeout Code Values

Constant Value of v Minimum Timeout

TNONE 0 disable (no timeout)

T10us 1 10 µs

T30us 2 30 µs

T100us 3 100 µs
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Possible Errors
EARG v  is invalid.
EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.

T300us 4 300 µs

T1ms 5 1 ms

T3ms 6 3 ms

T10ms 7 10 ms

T30ms 8 30 ms

T100ms 9 100 ms

T300ms 10 300 ms

T1s 11 1 s

T3s 12 3 s

T10s 13 10 s

T30s 14 30 s

T100s 15 100 s

T300s 16 300 s

T1000s 17 1000 s

Table 1-9.  Timeout Code Values (Continued)

Constant Value of v Minimum Timeout
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IBTRG
Device Level

Purpose
Trigger selected device.

Format
C
int ibtrg (int ud)

Visual Basic
CALL ibtrg (ud%)  

or

status% = iltrg (ud%)

Input
ud Device descriptor

Output
Function Return The value of ibsta

Description
ibtrg  sends the Group Execute Trigger (GET) message to the device described by ud.

Possible Errors
EARG ud is a valid descriptor but does not refer to a device.
EBUS No devices are connected to the GPIB.
ECIC The access interface is not Controller-In-Charge. Refer to the NI-488.2 online 

help for more information. To view the online help, select Start»Programs» 
National Instruments NI-488.2»Explore GPIB and select the Measurement 
& Automation  icon. Then, select a GPIB interface under Devices and 
Interfaces, right-click, and choose NI-488.2 Help.

EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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IBWAIT
Board Level/Device Level

Purpose
Wait for GPIB events.

Format
C
int ibwait (int ud, int mask)

Visual Basic
CALL ibwait (ud%, mask%)  

or

status% = ilwait (ud%, mask%)

Input
ud Interface or device descriptor
mask Bit mask of GPIB events to wait for

Output
Function Return The value of ibsta

Description
ibwait  monitors the events specified by mask and delays processing until one or more of th
events occurs. If the wait mask is zero, ibwait  returns immediately with the updated ibsta  
status word. If TIMO is set in the wait mask, ibwait  returns when the timeout period has 
elapsed, if one or more of the other specified events have not already occurred. If TIMO 
set in the wait mask, the function waits indefinitely for one or more of the specified even
occur. The existing ibwait  mask bits are identical to the ibsta  bits; they are described in 
Table 1-10. If ud is a device descriptor, the only valid wait mask bits are TIMO, END, RQ
and CMPL. If ud is an interface descriptor, all wait mask bits are valid except for RQS. Y
can configure the timeout period using the ibtmo  function.
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Possible Errors
EARG The bit set in mask is invalid.
EBUS Device level: No devices are connected to the GPIB.
ECIC Device level: The access interface is not Controller-In-Charge. Refer to th 

NI-488.2 online help for more information. To view the online help, select 
Start»Programs»National Instruments NI-488.2»Explore GPIB and select 
the Measurement & Automation icon. Then, select a GPIB interface under 
Devices and Interfaces, right-click, and choose NI-488.2 Help.

EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
ESRQ Device level: If RQS is set in the wait mask, ESRQ indicates that the Stuck SRQ 

condition exists. For more information about serial polling, refer to the 
NI-488.2 online help. To view the online help, select Start»Programs» 
National Instruments NI-488.2»Explore GPIB and select the Measurement 
& Automation  icon. Then, select a GPIB interface under Devices and 
Interfaces, right-click, and choose NI-488.2 Help.

Table 1-10.  Wait Mask Layout

Mnemonic
Bit 

Position
Hex 

Value Description

TIMO 14 4000 Use the timeout period (see ibtmo ) to limit the notify period

END 13 2000 END or EOS is detected

SRQI 12 1000 SRQ is asserted (board-level only)

RQS 11 800 Device requested service (device-level only)

CMPL 8 100 I/O completed

LOK 7 80 GPIB interface is in Lockout State (board-level only)

REM 6 40 GPIB interface is in Remote State (board-level only)

CIC 5 20 GPIB interface is Controller-In-Charge (board-level only)

ATN 4 10 Attention is asserted (board-level only)

TACS 3 8 GPIB interface is Talker (board-level only)

LACS 2 4 GPIB interface is Listener (board-level only)

DTAS 1 2 GPIB interface is in Device Trigger State (board-level only)

DCAS 0 1 GPIB interface is in Device Clear State (board-level only)
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IBWRT
Board Level/Device Level

Purpose
Write data to a device from a user buffer.

Format
C
int ibwrt (int ud, void *wrtbuf, long count)

Visual Basic
CALL ibwrt (ud%, wrtbuf$)

or

status% = ilwrt (ud%, wrtbuf$, count&)

Input
ud Interface or device descriptor
wrtbuf Address of the buffer containing the bytes to write
count Number of bytes to be written

Output
Function Return The value of ibsta

Description
Device Level
If ud is a device descriptor, ibwrt  addresses the GPIB and writes count  bytes from the 
memory location specified by wrtbuf  to a GPIB device. The operation terminates normal
when count  bytes have been sent. The operation terminates with an error if count  bytes 
could not be sent within the timeout period. The actual number of bytes transferred is ret
in the global variable ibcntl .

Board Level
If ud is an interface descriptor, ibwrt  writes count  bytes of data from the buffer specified
by wrtbuf  to a GPIB device; a board-level ibwrt  assumes that the GPIB is already proper
addressed. The operation terminates normally when count  bytes have been sent. The 
operation terminates with an error if count  bytes could not be sent within the timeout perio
or, if the interface is not CIC, the CIC sends Device Clear on the GPIB. The actual numb
bytes transferred is returned in the global variable ibcntl .
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Possible Errors
EABO Either count  bytes were not sent within the timeout period, or a Device Cle

message was received after the write operation began.
EADR Board level: The GPIB is not correctly addressed; use ibcmd  to address 

the GPIB.
Device level: A conflict exists between the device GPIB address and the G
address of the device access interface. Use ibpad  and ibsad .

EBUS Device level: No devices are connected to the GPIB.
ECIC Device level: The access interface is not Controller-In-Charge. Refer to th 

NI-488.2 online help for more information. To view the online help, select 
Start»Programs»National Instruments NI-488.2»Explore GPIB and select 
the Measurement & Automation icon. Then, select a GPIB interface under 
Devices and Interfaces, right-click, and choose NI-488.2 Help.

EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
ENOL No Listeners were detected on the bus.
EOIP Asynchronous I/O is in progress.
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IBWRTA
Board Level/Device Level

Purpose
Write data asynchronously to a device from a user buffer.

Format
C
int ibwrta (int ud, int *wrtbuf, long count)

Visual Basic
CALL ibwrta (ud%, wrtbuf$)

or

status% = ilwrta (ud%, wrtbuf$, count&)

Input
ud Interface or device descriptor
wrtbuf Address of the buffer containing the bytes to write
count Number of bytes to be written

Output
Function Return The value of ibsta

Description
Device Level
If ud is a device descriptor, ibwrta  addresses the GPIB properly and writes count  bytes 
from wrtbuf  to a GPIB device. The operation terminates normally when count  bytes have 
been sent. The actual number of bytes transferred is returned in the global variable ibcntl .

Board Level
If ud is an interface descriptor, ibwrta  begins an asynchronous write of count  bytes of data 
from wrtbuf  to a GPIB device. A board-level ibwrta  assumes that the GPIB is already 
properly addressed. The operation terminates normally when count  bytes have been sent. 
The operation terminates with an error if the interface is not the CIC, and the CIC send
Device Clear on the GPIB. The actual number of bytes transferred is returned in the gl
variable ibcntl .
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Board and Device Level
The asynchronous I/O calls (ibcmda , ibrda , ibwrta)  are designed so that applications ca
perform other non-GPIB operations with the I/O in progress. Once the asynchronous I
begins, further NI-488.2 calls are strictly limited. Any calls that would interfere with the 
in progress are not allowed; the driver returns EOIP in this case.

Once the I/O is complete, the application must resynchronize with the NI-488.2 driver. 
Resynchronization is accomplished by using one of the following functions:
ibnotify If the ibsta  value passed to the ibnotify  callback contains 

CMPL, the driver and application are resynchronized.
ibwait If the returned ibsta  contains CMPL, the driver and application

are resynchronized.
ibstop The I/O is canceled; the driver and application are resynchroniz
ibonl The I/O is canceled and the interface is reset; the driver and 

application are resynchronized.

Possible Errors
EABO Board level: A Device Clear message was received from the CIC.
EADR Board level: The NI-488.2 is not correctly addressed; use ibcmd  to address 

the GPIB.
Device level: A conflict exists between the device GPIB address and the G
address of the device access interface. Use ibpad  and ibsad .

EBUS Device level: No devices are connected to the GPIB.
ECIC Device level: The access interface is not Controller-In-Charge. Refer to th 

NI-488.2 online help for more information. To view the online help, select 
Start»Programs»National Instruments NI-488.2»Explore GPIB and select 
the Measurement & Automation icon. Then, select a GPIB interface under 
Devices and Interfaces, right-click, and choose NI-488.2 Help.

EDVR Either ud is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
ENOL No Listeners were detected on the bus.
EOIP Asynchronous I/O is in progress.
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IBWRTF
Board Level/Device Level

Purpose
Write data to a device from a file.

Format
C
int ibwrtf (int ud, char *flname)

Visual Basic
CALL ibwrtf (ud%, flname$)

or

status% = ilwrtf (ud%, flname$)

Input
ud Interface or device descriptor
flname Name of file containing the data to be written

Output
Function Return The value of ibsta

Description
Device Level
If ud is a device descriptor, ibwrtf  addresses the GPIB and writes all of the bytes from t
file flname  to a GPIB device. The operation terminates normally when all of the bytes h
been sent. The operation terminates with an error if all of the bytes could not be sent w
the timeout period. The actual number of bytes transferred is returned in the global var
ibcntl .

Board Level
If ud is an interface descriptor, ibwrtf  writes all of the bytes of data from the file flname  to 
a GPIB device. A board-level ibwrtf  assumes that the GPIB is already properly address
The operation terminates normally when all of the bytes have been sent. The operation
terminates with an error if all of the bytes could not be sent within the timeout period, o
the interface is not CIC, the CIC sends a Device Clear on the GPIB. The actual numbe
bytes transferred is returned in the global variable ibcntl .
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Possible Errors
EABO Either the file could not be transferred within the timeout period, or a Devic

Clear message was received after the write operation began.
EADR Board level: The GPIB is not correctly addressed; use ibcmd  to address 

the GPIB.
Device level: A conflict exists between the device GPIB address and the G
address of the device access interface. Use ibpad  and ibsad .

EBUS Device level: No devices are connected to the GPIB.
ECIC Device level: The access interface is not Controller-In-Charge. Refer to th 

NI-488.2 online help for more information. To view the online help, select 
Start»Programs»National Instruments NI-488.2»Explore GPIB and select 
the Measurement & Automation icon. Then, choose Help»Help Topics and 
select NI-488.2 Help.

EDVR Either ud is invalid or the NI-488.2 driver is not installed.
EFSO ibwrtf  could not access flname .
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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NI-488.2 API:
Multi-Device Calls

This chapter lists the NI-488.2 routines and describes the purpose, format, input and o
parameters, and possible errors for each routine.

For general programming information, refer to the NI-488.2 online help. To view the on
help, select Start»Programs»National Instruments NI-488.2»Explore GPIB. Then, select 
a GPIB interface under Devices and Interfaces, right-click, and choose NI-488.2 Help.

Routine Names
The routines in this chapter are listed alphabetically.

Purpose
Each routine description includes a brief statement of the purpose of the routine.

Format
The format section describes the format of each routine in the following languages: Micr
Visual C/C++ (version 2.0 or later), Borland C/C++ (version 4.0 or later), and Microsoft
Visual Basic (version 4.0 or later).

Input and Output
The input and output parameters for each routine are also listed. Most of the NI-488.2 ro
have an input parameter which is either a single address or a list of addresses. The ad
parameter is a 16-bit integer that has two components: the low byte is a valid primary ad
(0 to 30), and the high byte is a valid secondary address (NO_SAD(0) or 96 to 126). A list of 
addresses is an array of single addresses. You must mark the end of the list with the co
NOADDR. An empty address list is either an array with only the NOADDR constant in it, or a 
NULL pointer.
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with 
The C language interface header file includes the definition of a type (typedef ) called 
Addr4882_t . Use the Addr4882_t  type when declaring addresses or address lists.

Description
The description section gives details about the purpose and effect of each routine.

Examples
For detailed and complete examples, refer to the example programs that are included 
your NI-488.2 software.

Possible Errors
Each routine description includes a list of errors that could occur when it is invoked.

List of NI-488.2 API: Multi-Device Calls
Table 2-1 contains an alphabetical list of the NI-488.2 routines.

Table 2-1.  NI-488.2 API: Multi-Device Calls

Routine Purpose

AllSpoll Serial poll all devices

DevClear Clear a single device

DevClearList Clear multiple devices

EnableLocal Enable operations from the front panel of devices 
(leave remote programming mode)

EnableRemote Enable remote GPIB programming for devices

FindLstn Find listening devices on the GPIB

FindRQS Determine which device is requesting service

PassControl Pass control to another device with Controller capability

PPoll Perform a parallel poll on the GPIB

PPollConfig Configure a device to respond to parallel polls

PPollUnconfig Unconfigure devices for parallel polls
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talk

ten
RcvRespMsg Read data bytes from a device that is already addressed to 

ReadStatusByte Serial poll a single device

Receive Read data bytes from a device

ReceiveSetup Address a device to be a Talker and the interface to be 
a Listener in preparation for RcvRespMsg

ResetSys Reset and initialize IEEE 488.2-compliant devices

Send Send data bytes to a device

SendCmds Send GPIB command bytes

SendDataBytes Send data bytes to devices that are already addressed to lis

SendIFC Reset the GPIB by sending interface clear

SendList Send data bytes to multiple GPIB devices

SendLLO Send the Local Lockout (LLO) message to all devices

SendSetup Set up devices to receive data in preparation for 
SendDataBytes

SetRWLS Place devices in Remote With Lockout State

TestSRQ Determine the current state of the GPIB Service Request 
(SRQ) line

TestSys Cause IEEE 488.2-compliant devices to conduct self tests

Trigger Trigger a device

TriggerList Trigger multiple devices

WaitSRQ Wait until a device asserts the GPIB Service Request 
(SRQ) line

Table 2-1.  NI-488.2 API: Multi-Device Calls (Continued)

Routine Purpose
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AllSpoll

Purpose
Serial poll all devices.

Format
C
void AllSpoll (int boardID, Addr4882_t *addrlist, short *resultlist)

Visual Basic
CALL AllSpoll (boardID%, addrlist%(), resultlist%())

Input
boardID The interface number
addrlist A list of device addresses that is terminated by NOADDR

Output
resultlist A list of serial poll response bytes corresponding to device 

addresses in addrlist

Description
AllSpoll  serial polls all of the devices described by addrlist . It stores the poll responses
in resultlist  and the number of responses in ibcntl .

Possible Errors
EABO One of the devices timed out instead of responding to the serial poll; 

ibcntl contains the index of the timed-out device.
EARG An invalid address appears in addrlist ; ibcntl  is the index of the invalid 

address in the addrlist  array.
EBUS No devices are connected to the GPIB. 
ECIC The interface is not the Controller-In-Charge; see SendIFC .
EDVR Either boardID  is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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DevClear

Purpose
Clear a single device.

Format
C
void DevClear (int boardID, Addr4882_t address)

Visual Basic
CALL DevClear (boardID%, address%)

Input
boardID The interface number
address Address of the device you want to clear

Description
DevClear  sends the Selected Device Clear (SDC) GPIB message to the device describ
address . If address  is the constant NOADDR, the Universal Device Clear (DCL) message 
sent to all devices.

Possible Errors
EARG The address  parameter is invalid.
EBUS No devices are connected to the GPIB.
ECIC The interface is not the Controller-In-Charge; see SendIFC .
EDVR Either boardID  is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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DevClearList

Purpose
Clear multiple devices.

Format
C
void DevClearList (int boardID, Addr4882_t *addrlist)

Visual Basic
CALL DevClearList (boardID%, addrlist%())

Input
boardID The interface number
addrlist A list of device addresses terminated by NOADDR that you want 

to clear

Description
DevClearList  sends the Selected Device Clear (SDC) GPIB message to all the devic
addresses described by addrlist . If addrlist  contains only the constant NOADDR, 
the Universal Device Clear (DCL) message is sent to all the devices on the bus.

Possible Errors
EARG An invalid address appears in addrlist ; ibcntl  is the index of the invalid 

address in the addrlist  array.
EBUS No devices are connected to the GPIB.
ECIC The interface is not the Controller-In-Charge; see SendIFC .
EDVR Either boardID  is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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EnableLocal

Purpose
Enable operations from the front panel of devices (leave remote programming mode).

Format
C
void EnableLocal (int boardID, Addr4882_t *addrlist)

Visual Basic
CALL EnableLocal (boardID%, addrlist%())

Input
boardID The interface number
addrlist A list of device addresses that is terminated by NOADDR

Description
EnableLocal  sends the Go To Local (GTL) GPIB message to all the devices describe
addrlist . This places the devices into local mode. If addrlist  contains only the constant
NOADDR, the Remote Enable (REN) GPIB line is unasserted.

Possible Errors
EARG An invalid address appears in addrlist ; ibcntl  is the index of the invalid 

address in the addrlist  array.
EBUS No devices are connected to the GPIB.
ECIC The interface is not the Controller-In-Charge; see SendIFC .
EDVR Either boardID  is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
ESAC The interface is not configured as System Controller.
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EnableRemote

Purpose
Enable remote GPIB programming for devices.

Format
C
void EnableRemote (int boardID, Addr4882_t *addrlist)

Visual Basic
CALL EnableRemote (boardID%, addrlist%())

Input
boardID The interface number
addrlist A list of device addresses that is terminated by NOADDR

Description
EnableRemote  asserts the Remote Enable (REN) GPIB line. All devices described by 
addrlist  are put into a listen-active state.

Possible Errors
EARG An invalid address appears in addrlist ; ibcntl  is the index of the invalid 

address in the addrlist  array.
EBUS No devices are connected to the GPIB.
ECIC The interface is not the Controller-In-Charge; see SendIFC .
EDVR Either boardID  is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
ESAC The interface is not configured as System Controller.
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FindLstn

Purpose
Find listening devices on the GPIB.

Format

C
void FindLstn (int boardID, Addr4882_t *padlist, 

Addr4882_t *resultlist, int limit)

Visual Basic
CALL FindLstn (boardID%, padlist%(), resultlist%(), limit%)

Input
boardID The interface number
padlist A list of primary addresses that is terminated by NOADDR

limit Total number of entries that can be placed in resultlist

Output
resultlist Addresses of all listening devices found by FindLstn  are placed 

in this array

Description
FindLstn  tests all of the primary addresses in padlist  as follows: If a device is present at
a primary address given in padlist , the primary address is stored in resultlist . 
Otherwise, all secondary addresses of the primary address are tested, and the addresse
devices found are stored in resultlist . No more than limit  addresses are stored in 
resultlist . ibcntl  contains the actual number of addresses stored in resultlist .

Possible Errors
EARG An invalid primary address appears in padlist ; ibcntl  is the index of the 

invalid address in the padlist  array.
EBUS No devices are connected to the GPIB.
ECIC The interface is not the Controller-In-Charge; see SendIFC .
EDVR Either boardID  is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
ETAB The number of devices found on the GPIB exceed limit .
© National Instruments Corporation 2-9 NI-488.2 Function Reference Manual for Windows



Chapter 2 NI-488.2 API: Multi-Device Calls — FindRQS

ce
FindRQS

Purpose
Determine which device is requesting service.

Format
C
void FindRQS (int boardID, Addr4882_t *addrlist, short *result)

Visual Basic
CALL FindRQS (boardID%, addrlist%(), result%)

Input
boardID The interface number
addrlist List of device addresses that is terminated by NOADDR

Output
result Serial poll response byte of the device that is requesting servi

Description
FindRQS serial polls the devices described by addrlist , in order, until it finds a device 
which is requesting service. The serial poll response byte is then placed in result . ibcntl  
contains the index of the device requesting service in addrlist . If none of the devices are 
requesting service, the index corresponding to NOADDR in addrlist  is returned in ibcntl  
and ETAB is returned in iberr .

Possible Errors
EARG An invalid address appears in addrlist ; ibcntl  is the index of the invalid 

address in the addrlist  array.
EBUS No devices are connected to the GPIB.
ECIC The interface is not the Controller-In-Charge; see SendIFC .
EDVR Either boardID  is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
ETAB None of the devices in addrlist  are requesting service or addrlist  contains 

only NOADDR. ibcntl  contains the index of NOADDR in addrlist .
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PassControl

Purpose
Pass control to another device with Controller capability.

Format
C
void PassControl (int boardID, Addr4882_t address)

Visual Basic
CALL PassControl (boardID%, address%)

Input
boardID The interface number
address Address of the device to which you want to pass control

Description
PassControl  sends the Take Control (TCT) GPIB message to the device described by
address . The device becomes Controller-In-Charge and the interface is no longer CIC

Possible Errors
EARG The address  parameter is invalid. It must be a valid primary/secondary 

address pair. It cannot be the constant NOADDR.
EBUS No devices are connected to the GPIB.
ECIC The interface is not the Controller-In-Charge; see SendIFC .
EDVR Either boardID  is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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PPoll

Purpose
Perform a parallel poll on the GPIB.

Format
C
void PPoll (int boardID, short *result)

Visual Basic
CALL PPoll (boardID%, result%)

Input
boardID The interface number

Output
result The parallel poll result

Description
PPoll  conducts a parallel poll and the result is placed in result . Each of the eight bits of 
result  represents the status information for each device configured for a parallel poll.
The interpretation of the status information is based on the latest parallel poll configura
command sent to each device (see PPollConfig  and PPollUnconfig ). The Controller can 
use parallel polling to obtain one-bit, device-dependent status messages from up to eig
devices simultaneously.

For more information about parallel polling, refer to the NI-488.2 online help. To view th
online help, select Start»Programs»National Instruments NI-488.2»Explore GPIB. 
Then, select a GPIB interface under Devices and Interfaces, right-click, and choose 
NI-488.2 Help.

Possible Errors
EBUS No devices are connected to the GPIB.
ECIC The interface is not the Controller-In-Charge; see SendIFC .
EDVR Either boardID  is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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PPollConfig

Purpose
Configure a device to respond to parallel polls.

Format
C
void PPollConfig (int boardID, Addr4882_t address, int dataline,

 int lineSense)

Visual Basic
CALL PPollConfig (boardID%, address%, dataline%, lineSense%)

Input
boardID The interface number
address Address of the device to be configured
dataline Data line (a value in the range of 1 to 8) on which the 

device responds to parallel polls
lineSense Sense (either 0 or 1) of the parallel poll response

Description
PPollConfig  configures the device described by address  to respond to parallel polls by 
asserting or not asserting the GPIB data line, dataline . If lineSense  equals the individual 
status (ist ) bit of the device, the assigned GPIB data line is asserted during a parallel 
Otherwise, the data line is not asserted during a parallel poll. The Controller can use pa
polling to obtain 1-bit, device-dependent status messages from up to eight devices 
simultaneously.

For more information about parallel polling, refer to the NI-488.2 online help. To view th
online help, select Start»Programs»National Instruments NI-488.2»Explore GPIB. 
Then, select a GPIB interface under Devices and Interfaces, right-click, and choose 
NI-488.2 Help.
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Possible Errors
EARG Either the address  parameter is invalid, dataline  is not in the range 1 to 8, 

or lineSense  is not 0 or 1. The address  must be a valid primary/secondary
address pair. It cannot be the constant NOADDR.

EBUS No devices are connected to the GPIB.
ECIC The interface is not the Controller-In-Charge; see SendIFC .
EDVR Either boardID  is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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PPollUnconfig

Purpose
Unconfigure devices for parallel polls.

Format
C
void PPollUnconfig (int boardID, Addr4882_t *addrlist)

Visual Basic
CALL PPollUnconfig (boardID%, addrlist%())

Input
boardID The interface number
addrlist A list of device addresses that is terminated by NOADDR

Description
PPollUnconfig  unconfigures all the devices described by addrlist  for parallel polls. 
If addrlist  contains only the constant NOADDR, the Parallel Poll Unconfigure (PPU) GPIB
message is sent to all GPIB devices. The devices unconfigured by this function do not
participate in subsequent parallel polls.

For more information about parallel polling, refer to the NI-488.2 online help. To view th
online help, select Start»Programs»National Instruments NI-488.2»Explore GPIB. 
Then, select a GPIB interface under Devices and Interfaces, right-click, and choose 
NI-488.2 Help.

Possible Errors
EARG An invalid address appears in addrlist ; ibcntl  is the index of the 

invalid address in the addrlist  array.
EBUS No devices are connected to the GPIB.
ECIC The interface is not the Controller-In-Charge; see SendIFC .
EDVR Either interfaceID  is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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RcvRespMsg

Purpose
Read data bytes from a device that is already addressed to talk.

Format
C
void RcvRespMsg (int boardID, void *buffer, long count, 

int termination)

Visual Basic
CALL RcvRespMsg (boardID%, buffer$, termination%)

Input
boardID The interface number
count Number of bytes read
termination Description of the data termination mode 

(STOPend or an 8-bit EOS character)

Output
buffer Stores the received data bytes

Description
RcvRespMsg reads up to count  bytes from the GPIB and places these bytes into buffer . 
Data bytes are read until either count  data bytes have been read or the termination condit
is detected. If the termination condition is STOPend, the read is stopped when a byte is 
received with the EOI line asserted. Otherwise, the read is stopped when the 8-bit EOS
character is detected. The actual number of bytes transferred is returned in the global va
ibcntl .

RcvRespMsg assumes that the interface is already in its listen-active state and a device
already addressed to be a Talker (see ReceiveSetup  or Receive ).
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Possible Errors
EABO The I/O timeout period elapsed before all the bytes were received.
EADR The interface is not in the listen-active state; use ReceiveSetup  to address the 

GPIB properly.
EARG The termination  parameter is invalid. It must be either STOPend or an 8-bit 

EOS character.
ECIC The interface is not the Controller-In-Charge; see SendIFC .
EDVR Either boardID  is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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ReadStatusByte

Purpose
Serial poll a single device.

Format
C
void ReadStatusByte (int boardID, Addr4882_t address, short *result)

Visual Basic
CALL ReadStatusByte (boardID%, address%, result%)

Input
boardID The interface number
address A device address

Output
result Serial poll response byte

Description
ReadStatusByte  serial polls the device described by address . The response byte is stored
in result .

Possible Errors
EABO The device times out instead of responding to the serial poll.
EARG The address  parameter is invalid.
EBUS No devices are connected to the GPIB.
ECIC The interface is not the Controller-In-Charge; see SendIFC .
EDVR Either boardID  is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
NI-488.2 Function Reference Manual for Windows 2-18 © National Instruments Corporation



Chapter 2 NI-488.2 API: Multi-Device Calls — Receive

, 

ion is 
wise, 
tes 
Receive

Purpose
Read data bytes from a device.

Format
C
void Receive (int boardID, Addr4882_t address, void *buffer, 

long count, int termination)

Visual Basic
CALL Receive (boardID%, address%, buffer$, termination%)

Input
boardID The interface number
address Address of a device to receive data
count Number of bytes to read
termination Description of the data termination mode (STOPend or an EOS 

character)

Output
buffer Stores the received data bytes

Description
Receive  addresses the device described by address  to talk and the interface to listen. Then
up to count  bytes are read and placed into the buffer. Data bytes are read until either count  
bytes have been read or the termination condition is detected. If the termination condit
STOPend, the read is stopped when a byte is received with the EOI line asserted. Other
the read is stopped when an 8-bit EOS character is detected. The actual number of by
transferred is returned in the global variable, ibcntl .

Possible Errors
EABO The I/O timeout period elapsed before all the bytes were received.
EARG The address  or termination  parameter is invalid. The address  must be a 

valid primary/secondary address pair. It cannot be the constant NOADDR.
EBUS No devices are connected to the GPIB.
ECIC The interface is not the Controller-In-Charge; see SendIFC .
EDVR Either boardID  is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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Purpose
Address a device to be a Talker and the interface to be a Listener in preparation for 
RcvRespMsg.

Format
C
void ReceiveSetup (int boardID, Addr4882_t address)

Visual Basic
CALL ReceiveSetup (boardID%, address%)

Input
boardID The interface number
address Address of a device to be talk addressed

Description
ReceiveSetup  makes the device described by address  talk-active, and makes the interface
listen-active. This call is usually followed by a call to RcvRespMsg to transfer data from 
the device to the interface. This routine is particularly useful to make multiple calls to 
RcvRespMsg; it eliminates the need to readdress the device to receive every block of da

Possible Errors
EARG The address  parameter is invalid.
EBUS No devices are connected to the GPIB.
ECIC The interface is not the Controller-In-Charge; see SendIFC .
EDVR Either boardID  is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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Purpose
Reset and initialize IEEE 488.2-compliant devices.

Format
C
void ResetSys (int boardID, Addr4882_t *addrlist)

Visual Basic
CALL ResetSys (boardID%, addrlist%())

Input
boardID The interface number
addrlist A list of device addresses that is terminated by NOADDR

Description
The reset and initialization take place in three steps. The first step resets the GPIB by as
the Remote Enable (REN) line and then the Interface Clear (IFC) line. The second step
all of the devices by sending the Universal Device Clear (DCL) GPIB message. The fina
causes IEEE 488.2-compliant devices to perform device-specific reset and initialization.
step is accomplished by sending the message "*RST\n"  to the devices described by 
addrlist .

Possible Errors
EABO I/O operation is aborted.
EARG Either an invalid address appears in addrlist  or addrlist  is empty; 

ibcntl is the index of the invalid address in the addrlist  array.
EBUS No devices are connected to the GPIB.
ECIC The interface is not the Controller-In-Charge; see SendIFC .
EDVR Either boardID  is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
ENOL No Listeners are on the GPIB.
EOIP Asynchronous I/O is in progress.
ESAC The interface is not System Controller.
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Purpose
Send data bytes to a device.

Format
C
void Send (int boardID, Addr4882_t address, void *buffer, 

long count, int eotmode)

Visual Basic
CALL Send (boardID%, address%, buffer$, eotmode%)

Input
boardID The interface number
address Address of a device to which data is sent
buffer The data bytes to be sent
count Number of bytes to be sent
eotmode The data termination mode: DABend, NULLend, or NLend

Description
Send addresses the device described by address  to listen and the interface to talk. Then, 
count  bytes from buffer  are sent to the device. The last byte is sent with the EOI line 
asserted if eotmode  is DABend. The last byte is sent without the EOI line asserted if eotmode  
is NULLend. If eotmode  is NLend, a new line character ('\n' ) is sent with the EOI line 
asserted after the last byte of buffer . The actual number of bytes transferred is returned 
the global variable, ibcntl .

Possible Errors
EABO The I/O timeout period has expired before all of the bytes were sent.
EARG Either the address  parameter or eotmode  parameter is invalid, or the buffer  

is empty and eotmode  is DABend. The address  must be a valid primary/sec-
ondary address pair; it cannot be the constant NOADDR. The eotmode  parameter 
can only be DABend, NULLend, or NLend.

EBUS No devices are connected to the GPIB.
ECIC The interface is not the Controller-In-Charge; see SendIFC .
EDVR Either boardID  is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
ENOL No Listeners are on the GPIB to accept the data bytes.
EOIP Asynchronous I/O is in progress.
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SendCmds

Purpose
Send GPIB command bytes.

Format
C
void SendCmds (int boardID, void *buffer, long count)

Visual Basic
CALL SendCmds (boardID%, buffer$)

Input
boardID The interface number
buffer Command bytes to be sent
count Number of bytes to be sent

Description
SendCmds sends count  command bytes from buffer  over the GPIB as command bytes 
(interface messages). The number of command bytes transferred is returned in the glo
variable ibcntl . Refer to Appendix A, Multiline Interface Messages, for a listing of the 
defined interface messages.

Use command bytes to configure the state of the GPIB, not to send instructions to GP
devices. Use Send or SendList  to send device-specific instructions.

Possible Errors
EABO The I/O timeout period expired before all of the command bytes were sent
ECIC The interface is not the Controller-In-Charge; see SendIFC .
EDVR Either boardID  is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
ENOL No devices are connected to the GPIB.
EOIP Asynchronous I/O is in progress.
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SendDataBytes

Purpose
Send data bytes to devices that are already addressed to listen.

Format
C
void SendDataBytes (int boardID, void *buffer, long count, 

int eotmode)

Visual Basic
CALL SendDataBytes (boardID%, buffer$, eotmode%)

Input
boardID The interface number
buffer The data bytes to be sent
count Number of bytes to be sent
eotmode The data termination mode: DABend, NULLend, or NLend

Description
SendDataBytes  sends count  number of bytes from the buffer to devices which are alrea
addressed to listen. The last byte is sent with the EOI line asserted if eotmode  is DABend; the 
last byte is sent without the EOI line asserted if eotmode  is NULLend. If eotmode  is NLend 
then a new line character ('\n' ) is sent with the EOI line asserted after the last byte. The
actual number of bytes transferred is returned in the global variable, ibcntl .

SendDataBytes  assumes that the interface is in talk-active state and that devices are al
addressed as Listeners on the GPIB (see SendSetup , Send, or SendList ).

Possible Errors
EABO The I/O timeout period expired before all of the bytes were sent.
EADR The interface is not talk-active; use SendSetup  to address the GPIB properly.
EARG Either the eotmode  parameter is invalid (it can only be DABend, NULLend, 

or NLend), or the buffer  is empty and the eotmode  is DABend.
ECIC The interface is not the Controller-In-Charge; see SendIFC .
EDVR Either boardID  is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
ENOL No Listeners are on the GPIB to accept the data bytes; use SendSetup  to 

address the GPIB properly.
EOIP Asynchronous I/O is in progress.
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SendIFC

Purpose
Reset the GPIB by sending interface clear.

Format
C
void SendIFC (int boardID)

Visual Basic
CALL SendIFC (boardID%)

Input
boardID The interface number

Description
SendIFC  is used as part of GPIB initialization. It forces the interface to be 
Controller-In-Charge of the GPIB. It also ensures that the connected devices are all 
unaddressed and that the interface functions of the devices are in their idle states.

Possible Errors
EDVR Either boardID  is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
ESAC The interface is not configured as the System Controller; see ibrsc .
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SendList

Purpose
Send data bytes to multiple GPIB devices.

Format
C
void SendList (int boardID, Addr4882_t *addrlist, void *buffer, 

long count, int eotmode)

Visual Basic
CALL SendList (boardID%, addrlist%(), buffer$, eotmode%)

Input
boardID The interface number
addrlist A list of device addresses to send data
buffer The data bytes to be sent
count Number of bytes transmitted
eotmode The data termination mode: DABend, NULLend, or NLend

Description
SendList  addresses the devices described by addrlist  to listen and the interface to talk. 
Then, count  bytes from buffer  are sent to the devices. The last byte is sent with the EO
line asserted if eotmode  is DABend. The last byte is sent without the EOI line asserted if 
eotmode  is NULLend. If eotmode  is NLend, a new line character ('\n' ) is sent with the EOI 
line asserted after the last byte. The actual number of bytes transferred is returned in the
variable, ibcntl .

Possible Errors
EABO The I/O timeout period expired before all of the bytes were sent.
EARG Either an invalid address appears in addrlist  or the addrlist  is empty 

(ibcntl  is the index of the invalid address), or the eotmode  parameter is 
invalid. The eotmode  parameter can only be DABend, NULLend, or NLend. 
If the buffer  is empty, an eotmode  of DABend is disallowed.

EBUS No devices are connected to the GPIB.
ECIC The interface is not the Controller-In-Charge; see SendIFC .
EDVR Either boardID  is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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Purpose
Send the Local Lockout (LLO) message to all devices.

Format
C
void SendLLO (int boardID)

Visual Basic
CALL SendLLO (boardID%)

Input
boardID The interface number

Description
SendLLO sends the GPIB Local Lockout (LLO) message to all devices. While Local Lock
is in effect, only the Controller-In-Charge can alter the state of the devices by sending 
appropriate GPIB messages. SendLLO is reserved for use in unusual local/remote situation
In the typical case of placing the devices in Remote With Local Lockout, you should con
SetRWLS.

Possible Errors
EBUS No devices are connected to the GPIB.
ECIC The interface is not the Controller-In-Charge; see SendIFC .
EDVR Either boardID  is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
ESAC The interface is not configured as System Controller.
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Purpose
Set up devices to receive data in preparation for SendDataBytes .

Format
C
void SendSetup (int boardID, Addr4882_t *addrlist)

Visual Basic
CALL SendSetup (boardID%, addrlist%())

Input
boardID The interface number
addrlist A list of device addresses that is terminated by NOADDR

Description
SendSetup  makes the devices described by addrlist  listen-active and makes the interface
talk-active. This call is usually followed by SendDataBytes  to actually transfer data from 
the interface to the devices. SendSetup  is particularly useful to set up the addressing befo
making multiple calls to SendDataBytes ; it eliminates the need to readdress the devices 
every block of data.

Possible Errors
EARG Either an invalid address appears in addrlist  or the addrlist  is empty; 

ibcntl  is the index of the invalid address in the addrlist  array.
EBUS No devices are connected to the GPIB.
ECIC The interface is not the Controller-In-Charge; see SendIFC .
EDVR Either boardID  is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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Purpose
Place devices in Remote With Lockout State.

Format
C
void SetRWLS (int boardID, Addr4882_t *addrlist)

Visual Basic
CALL SetRWLS (boardID%, addrlist%())

Input
boardID The interface number
addrlist A list of device addresses that is terminated by NOADDR

Description
SetRWLS places the devices described by addrlist  in remote mode by asserting the 
Remote Enable (REN) GPIB line. Then, those devices are placed in lockout state by th
Local Lockout (LLO) GPIB message. You cannot program those devices locally until th
Controller-In-Charge releases the Local Lockout by way of the EnableLocal  NI-488.2 
routine.

Possible Errors
EARG Either an invalid address appears in addrlist  or the addrlist  is empty; 

ibcntl  is the index of the invalid address in the addrlist  array.
EBUS No devices are connected to the GPIB.
ECIC The interface is not the Controller-In-Charge; see SendIFC .
EDVR Either boardID  is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
ESAC The interface is not configured as System Controller.
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TestSRQ

Purpose
Determine the current state of the GPIB Service Request (SRQ) line.

Format
C
void TestSRQ (int boardID, short *result)

Visual Basic
CALL TestSRQ (boardID%, result%)

Input
boardID The interface number

Output
result State of the SRQ line: non-zero if the line is asserted, zero if t

line is not asserted

Description
TestSRQ returns the current state of the GPIB SRQ line in result . If SRQ is asserted, 
result  contains a non-zero value. Otherwise, result  contains a zero. Use TestSRQ to 
get the current state of the GPIB SRQ line. Use WaitSRQ to wait until SRQ is asserted.

Possible Errors
EDVR Either boardID  is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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Purpose
Cause IEEE 488.2-compliant devices to conduct self tests.

Format
C
void TestSys (int boardID, Addr4882_t *addrlist, short *resultlist)

Visual Basic
CALL TestSys (boardID%, addrlist%(), resultlist%())

Input
boardID The interface number
addrlist A list of device addresses terminated by NOADDR

Output
resultlist A list of test results; each entry corresponds to an address in 

addrlist

Description
TestSys  sends the "*TST?"  message to the IEEE 488.2-compliant devices described b
addrlist . The "*TST?"  message instructs them to conduct their self-test procedures. 
16-bit test result code is read from each device and stored in resultlist . A test result of 
0\n  indicates that the device passed its self test. Refer to the documentation that came
the device to determine the meaning of the failure code. Any other value indicates that
device failed its self test. If the function returns without an error (that is, the ERR bit is no
in ibsta ), ibcntl  contains the number of devices that failed. Otherwise, the meaning 
ibcntl  depends on the error returned. If a device fails to send a response before the ti
period expires, a test result of –1 is reported for it, and the error EABO is returned.
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Possible Errors
EABO The interface timed out before receiving a result from a device; ibcntl  

contains the index of the timed-out device. –1 is stored as the test result fo
the timed-out device.

EARG Either an invalid address appears in addrlist  or the addrlist  is empty; 
ibcntl  is the index of the invalid address in the addrlist  array.

EBUS No devices are connected to the GPIB.
ECIC The interface is not the Controller-In-Charge; see SendIFC .
EDVR Either boardID  is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
ENOL No Listeners are on the GPIB.
EOIP Asynchronous I/O is in progress.
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Purpose
Trigger a device.

Format
C
void Trigger (int boardID, Addr4882_t address)

Visual Basic
CALL Trigger (boardID%, address%)

Input
boardID The interface number
address Address of a device to be triggered

Description
Trigger  sends the Group Execute Trigger (GET) GPIB message to the device describ
address . If address  is the constant NOADDR, the GET message is sent to all devices that a
currently listen-active on the GPIB.

Possible Errors
EARG The address  parameter is invalid.
EBUS No devices are connected to the GPIB.
ECIC The interface is not the Controller-In-Charge; see SendIFC .
EDVR Either boardID  is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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TriggerList

Purpose
Trigger multiple devices.

Format
C
void TriggerList (int boardID, Addr4882_t *addrlist)

Visual Basic
CALL TriggerList (boardID%, addrlist%())

Input
boardID The interface number
addrlist A list of device addresses terminated by NOADDR

Description
TriggerList  sends the Group Execute Trigger (GET) GPIB message to the devices 
described by addrlist . If the only address in addrlist  is the constant NOADDR, 
no addressing is performed and the GET message is sent to all devices that are curren
listen-active on the GPIB.

Possible Errors
EARG An invalid address appears in addrlist ; ibcntl  is the index of the invalid 

address in the addrlist  array.
EBUS No devices are connected to the GPIB.
ECIC The interface is not the Controller-In-Charge; see SendIFC .
EDVR Either boardID  is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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Purpose
Wait until a device asserts the GPIB Service Request (SRQ) line.

Format
C
void WaitSRQ (int boardID, short *result)

Visual Basic
CALL WaitSRQ (boardID%, result%)

Input
boardID The interface number

Output
result State of the SRQ line: non-zero if line is asserted, zero if line is 

asserted

Description
WaitSRQ waits until either the GPIB SRQ line is asserted or the timeout period has exp
(see ibtmo ). When WaitSRQ returns, result  contains a non-zero if SRQ is asserted. 
Otherwise, result  contains a zero. Use TestSRQ to get the current state of the GPIB SRQ
line. Use WaitSRQ to wait until SRQ is asserted.

Possible Errors
EDVR Either boardID  is invalid or the NI-488.2 driver is not installed.
ENEB The interface is not installed or is not properly configured.
EOIP Asynchronous I/O is in progress.
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Supplemental Calls for 
Multithreaded Applications

This chapter lists the supplemental functions designed for multithreaded applications a
describes the purpose, format, and input and output parameters for each function.

For general programming information, refer to the NI-488.2 online help. To view the on
help, select Start»Programs»National Instruments NI-488.2»Explore GPIB. Then, select 
a GPIB interface under Devices and Interfaces, right-click, and choose NI-488.2 Help.

Function Names
The functions in this chapter are listed alphabetically.

Purpose
Each function description includes a brief statement of the purpose of the function.

Format
The format section describes the format of each function in the following languages: 
Microsoft Visual C/C++ (version 2.0 or later), Borland C/C++ (version 4.0 or later), and
Microsoft Visual Basic (version 4.0 or later).

Input and Output
The input and output parameters for each function are listed. Function Return describe
return value of the function.

Description
The description section gives details about the purpose and effect of each function.
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List of Supplemental Calls
Table 3-1 contains an alphabetical list of the supplemental calls for multithreaded 
applications.

Table 3-1.  Supplemental Calls for Multithreaded Applications

Function Purpose

ThreadIbcnt Return the value of the thread-specific ibcnt

ThreadIbcntl Return the value of the thread-specific ibcntl

ThreadIberr Return the value of the thread-specific iberr

ThreadIbsta Return the value of the thread-specific ibsta
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ThreadIbcnt

Purpose
Return the value of the thread-specific ibcnt .

Format

C
int ThreadIbcnt ()

Visual Basic
rc% = ThreadIbcnt ()

Input
none No input parameters

Output
Function Return Value of ibcnt  for the calling thread

Description
ThreadIbcnt  returns the current value of ibcnt  for a particular thread of execution. The 
global NI-488.2 status variables (ibsta , iberr , ibcnt , ibcntl ) are maintained on a per 
process basis, which means that their values are updated whenever any thread in that 
makes NI-488.2 calls. The thread NI-488.2 status variables are maintained on a per th
basis, which means that their values are updated whenever that particular thread mak
NI-488.2 calls. If your application performs NI-488.2 operations in multiple threads, you
application should examine the thread NI-488.2 status variables using ThreadIbsta , 
ThreadIberr , ThreadIbcnt , and ThreadIbcntl  instead of the global NI-488.2 status 
variables.
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Purpose
Return the value of the thread-specific ibcntl .

Format

C
long ThreadIbcntl ()

Visual Basic
rc& = ThreadIbcntl ()

Input
none No input parameters

Output
Function Return Value of ibcntl  for the calling thread

Description
ThreadIbcntl  returns the current value of ibcntl  for a particular thread of execution. The
global NI-488.2 status variables (ibsta , iberr , ibcnt , ibcntl ) are maintained on a per 
process basis, which means that their values are updated whenever any thread in that 
makes NI-488.2 calls. The thread NI-488.2 status variables are maintained on a per th
basis, which means that their values are updated whenever that particular thread mak
NI-488.2 calls. If your application performs NI-488.2 operations in multiple threads, you
application should examine the thread NI-488.2 status variables using ThreadIbsta , 
ThreadIberr , ThreadIbcnt , and ThreadIbcntl  instead of the global NI-488.2 status 
variables.
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Purpose
Return the value of the thread-specific iberr .

Format

C
int ThreadIberr ()

Visual Basic
rc% = ThreadIberr ()

Input
none No input parameters

Output
Function Return Value of iberr  for the calling thread

Description
ThreadIberr  returns the current value of iberr  for a particular thread of execution. The 
global NI-488.2 status variables (ibsta , iberr , ibcnt , ibcntl ) are maintained on a per 
process basis, which means that their values are updated whenever any thread in that 
makes NI-488.2 calls. The thread NI-488.2 status variables are maintained on a per th
basis, which means that their values are updated whenever that particular thread mak
NI-488.2 calls. If your application performs NI-488.2 operations in multiple threads, you
application should examine the thread NI-488.2 status variables using ThreadIbsta , 
ThreadIberr , ThreadIbcnt , and ThreadIbcntl  instead of the global NI-488.2 status 
variables.
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Purpose
Return the value of the thread-specific ibsta .

Format

C
int ThreadIbsta ()

Visual Basic
rc% = ThreadIbsta ()

Input
none No input parameters

Output
Function Return Value of ibsta  for the calling thread

Description
ThreadIbsta  returns the current value of ibsta  for a particular thread of execution. The 
global NI-488.2 status variables (ibsta , iberr , ibcnt , ibcntl ) are maintained on a per 
process basis, which means that their values are updated whenever any thread in that 
makes NI-488.2 calls. The thread NI-488.2 status variables are maintained on a per th
basis, which means that their values are updated whenever that particular thread mak
NI-488.2 calls. If your application performs NI-488.2 operations in multiple threads, you
application should examine the thread NI-488.2 status variables using ThreadIbsta , 
ThreadIberr , ThreadIbcnt , and ThreadIbcntl  instead of the global NI-488.2 status 
variables.
NI-488.2 Function Reference Manual for Windows 3-6 © National Instruments Corporation



© National Instruments Corporation A-1 NI-488.2 Function Reference Ma
A

ich 

ace 
ith 

 

Multiline Interface Messages

This appendix contains a multiline interface message reference list, wh
describes the mnemonics and messages that correspond to the interf
functions. These multiline interface messages are sent and received w
ATN asserted.

For more information about these messages, refer to the ANSI/IEEE 
Standard 488.1-1987, IEEE Standard Digital Interface for Programmable
Instrumentation.
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Table A-1.  Multiline Interface Messages

Hex Dec ASCII Msg Hex Dec ASCII Msg

00 0 NUL 20  32 SP MLA0

01 1 SOH GTL 21  33 ! MLA1

02 2 STX 22  34 " MLA2

03 3 ETX 23  35 # MLA3

04 4 EOT SDC 24  36 $ MLA4

05 5 ENQ PPC 25  37 % MLA5

06 6 ACK 26  38 & MLA6

07 7 BEL 27  39 ' MLA7

08 8 BS GET 28  40 ( MLA8

09 9 HT TCT 29  41 ) MLA9

0A 10 LF 2A  42 * MLA10

0B 11 VT 2B  43 + MLA11

0C 12 FF 2C  44 , MLA12

0D 13 CR 2D  45 - MLA13

0E 14 SO 2E  46 . MLA14

0F 15 SI 2F  47 / MLA15

10 16 DLE 30  48 0 MLA16

11 17 DC1 LLO 31  49 1 MLA17

12 18 DC2 32  50 2 MLA18

13 19 DC3 33  51 3 MLA19

14 20 DC4 DCL 34  52 4 MLA20

15 21 NAK PPU 35  53 5 MLA21

16 22 SYN 36  54 6 MLA22

17 23 ETB 37  55 7 MLA23

18 24 CAN SPE 38  56 8 MLA24

19 25 EM SPD 39  57 9 MLA25

1A 26 SUB 3A  58 : MLA26

1B 27 ESC 3B  59 ; MLA27

1C 28 FS 3C  60 < MLA28

1D 29 GS 3D  61 = MLA29

1E 30 RS 3E  62 > MLA30

1F 31 US CFE 3F  63 ? UNL
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40 64 @ MTA0 60 96 ` MSA0, PPE

41 65 A MTA1 61 97 a MSA1, PPE, CFG1

42 66 B MTA2 62 98 b MSA2, PPE, CFG2

43 67 C MTA3 63 99 c MSA3, PPE, CFG3

44 68 D MTA4 64 100 d MSA4, PPE, CFG4

45 69 E MTA5 65 101 e MSA5, PPE, CFG5

46 70 F MTA6 66 102 f MSA6, PPE, CFG6

47 71 G MTA7 67 103 g MSA7, PPE, CFG7

48 72 H MTA8 68 104 h MSA8, PPE, CFG8

49 73 I MTA9 69 105 i MSA9, PPE, CFG9

4A 74 J MTA10 6A 106 j MSA10, PPE, CFG10

4B 75 K MTA11 6B 107 k MSA11, PPE, CFG11

4C 76 L MTA12 6C 108 l MSA12, PPE, CFG12

4D 77 M MTA13 6D 109 m MSA13, PPE, CFG13

4E 78 N MTA14 6E 110 n MSA14, PPE, CFG14

4F 79 O MTA15 6F 111 o MSA15, PPE, CFG15

50 80 P MTA16 70 112 p MSA16, PPD

51 81 Q MTA17 71 113 q MSA17, PPD

52 82 R MTA18 72 114 r MSA18, PPD

53 83 S MTA19 73 115 s MSA19, PPD

54 84 T MTA20 74 116 t MSA20, PPD

55 85 U MTA21 75 117 u MSA21, PPD

56 86 V MTA22 76 118 v MSA22, PPD

57 87 W MTA23 77 119 w MSA23, PPD

58 88 X MTA24 78 120 x MSA24, PPD

59 89 Y MTA25 79 121 y MSA25, PPD

5A 90 Z MTA26 7A 122 z MSA26, PPD

5B 91 [ MTA27 7B 123 { MSA27, PPD

5C 92 \ MTA28 7C 124 | MSA28, PPD

5D 93 ] MTA29 7D 125 } MSA29, PPD

5E 94 ^ MTA30 7E 126 ~ MSA30, PPD

5F 95 _ UNT 7F 127 DEL

Table A-1.  Multiline Interface Messages (Continued)

Hex Dec ASCII Msg Hex Dec ASCII Msg
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-speed 
Multiline Interface Message Definitions

CFE †Configuration Enable
CFG †Configure
DCLDevice Clear
GETGroup Execute Trigger
GTLGo To Local
LLOLocal Lockout
MLAMy Listen Address
MSAMy Secondary Address
MTAMy Talk Address
PPCParallel Poll Configure

PPDParallel Poll Disable
PPEParallel Poll Enable
PPUParallel Poll Unconfigure
SDCSelected Device Clear
SPDSerial Poll Disable
SPESerial Poll Enable
TCTTake Control
UNLUnlisten
UNTUntalk

†This multiline interface message is a proposed extension to the IEEE 488.1 specification to support the HS488 high
protocol.
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Status Word Conditions

This appendix gives a detailed description of the conditions reported in
status word, ibsta .

For information about how to use ibsta  in your application, refer to the 
NI-488.2 online help. To view the online help, select Start»Programs» 
National Instruments NI-488.2»Explore GPIB. Then, select a GPIB 
interface under Devices and Interfaces, right-click, and choose NI-488.2 
Help.

Each bit in ibsta  can be set for device calls (dev), board calls (brd), or bo
(dev, brd).

The following table shows the status word layout.

Mnemonic
Bit 

Position Hex Value Type Description

ERR 15 8000 dev, brd NI-488.2 error 

TIMO 14 4000 dev, brd Time limit exceeded 

END 13 2000 dev, brd END or EOS detected 

SRQI 12 1000 brd SRQ interrupt received 

RQS 11 800 dev Device requesting service

CMPL 8 100 dev, brd I/O completed 

LOK 7 80 brd Lockout State 

REM 6 40 brd Remote State 

CIC 5 20 brd Controller-In-Charge 

ATN 4 10 brd Attention is asserted 

TACS 3 8 brd Talker

LACS 2 4 brd Listener
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ERR (dev, brd)
ERR is set in the status word following any call that results in an error. Y
can determine the particular error by examining the error variable iberr . 
Appendix C, Error Codes and Solutions, describes error codes that are 
recorded in iberr  along with possible solutions. ERR is cleared followin
any call that does not result in an error.

TIMO (dev, brd)
TIMO indicates that the timeout period has expired. TIMO is set in the
status word following any synchronous I/O functions (for example, ibcmd , 
ibrd , ibwrt , Receive , Send, and SendCmds) if the timeout period 
expires before the I/O operation has completed. TIMO is also set in th
status word following an ibwait  or ibnotify  call if the TIMO bit is set 
in the mask parameter and the timeout period expires before any other
specified mask bit condition occurs. TIMO is cleared in all other 
circumstances.

END (dev, brd)
END indicates either that the GPIB EOI line has been asserted or that
EOS byte has been received, if the software is configured to terminate
read on an EOS byte. If the GPIB interface is performing a shadow 
handshake as a result of the ibgts  function, any other function can return
a status word with the END bit set if the END condition occurs before 
during that call. END is cleared when any I/O operation is initiated.

Some applications might need to know the exact I/O read termination m
of a read operation—EOI by itself, the EOS character by itself, or EOI 
plus the EOS character. You can use the ibconfig  function (option 
IbcEndBitIsNormal ) to enable a mode in which the END bit is set onl
when EOI is asserted. In this mode, if the I/O operation completes bec
of the EOS character by itself, END is not set. The application should ch
the last byte of the received buffer to see if it is the EOS character.

DTAS 1 2 brd Device Trigger State 

DCAS 0 1 brd Device Clear State

Mnemonic
Bit 

Position Hex Value Type Description
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SRQI (brd)
SRQI indicates that a GPIB device is requesting service. SRQI is set 
whenever the GPIB interface is CIC, the GPIB SRQ line is asserted, and
automatic serial poll capability is disabled. SRQI is cleared either when
GPIB interface ceases to be the CIC or when the GPIB SRQ line is 
unasserted.

RQS (dev)
RQS appears in the status word only after a device-level call and indic
that the device is requesting service. RQS is set whenever one or mor
positive serial poll response bytes have been received from the device
positive serial poll response byte always has bit 6 asserted. Automatic s
polling must be enabled (it is enabled by default) for RQS to automatica
appear in ibsta . You can also wait for a device to request service 
regardless of the state of automatic serial polling by calling ibwait  with a 
mask that contains RQS. Do not issue an ibwait  call on RQS for a device 
that does not respond to serial polls. Use ibrsp  to acquire the serial poll 
response byte that was received. RQS is cleared when all of the stored 
poll response bytes have been reported to you through the ibrsp  function.

CMPL (dev, brd)
CMPL indicates the condition of I/O operations. It is set whenever an I
operation is complete. CMPL is cleared while the I/O operation is in 
progress.

LOK (brd)
LOK indicates whether the interface is in a lockout state. While LOK is s
the EnableLocal  routine or ibloc  function is inoperative for that 
interface. LOK is set whenever the GPIB interface detects that the Loc
Lockout (LLO) message has been sent either by the GPIB interface or
another Controller. LOK is cleared when the System Controller unasse
the Remote Enable (REN) GPIB line.
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REM (brd)
REM indicates whether the interface is in the remote state. REM is se
whenever the Remote Enable (REN) GPIB line is asserted and the GP
interface detects that its listen address has been sent either by the GP
interface or by another Controller. REM is cleared in the following 
situations:

• When REN becomes unasserted

• When the GPIB interface as a Listener detects that the Go to Loca
(GTL) command has been sent either by the GPIB interface or by
another Controller

• When the ibloc  function is called while the LOK bit is cleared in the
status word

CIC (brd)
CIC indicates whether the GPIB interface is the Controller-In-Charge. C
is set when the SendIFC  routine or ibsic  function is executed either while
the GPIB interface is System Controller or when another Controller pas
control to the GPIB interface. CIC is cleared either when the GPIB 
interface detects Interface Clear (IFC) from the System Controller or w
the GPIB interface passes control to another device.

ATN (brd)
ATN indicates the state of the GPIB Attention (ATN) line. ATN is set 
whenever the GPIB ATN line is asserted, and it is cleared when the AT
line is unasserted.

TACS (brd)
TACS indicates whether the GPIB interface is addressed as a Talker. T
is set whenever the GPIB interface detects that its talk address (and 
secondary address, if enabled) has been sent either by the GPIB inter
itself or by another Controller. TACS is cleared whenever the GPIB 
interface detects the Untalk (UNT) command, its own listen address, a
address other than its own talk address, or Interface Clear (IFC).
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LACS (brd)
LACS indicates whether the GPIB interface is addressed as a Listene
LACS is set whenever the GPIB interface detects that its listen address
secondary address, if enabled) has been sent either by the GPIB inter
itself or by another Controller. LACS is also set whenever the GPIB 
interface shadow handshakes as a result of the ibgts  function. LACS is 
cleared whenever the GPIB interface detects the Unlisten (UNL) comma
its own talk address, Interface Clear (IFC), or that the ibgts  function has 
been called without shadow handshake.

DTAS (brd)
DTAS indicates whether the GPIB interface has detected a device trig
command. DTAS is set whenever the GPIB interface, as a Listener, de
that the Group Execute Trigger (GET) command has been sent by ano
Controller. DTAS is cleared on any call immediately following an ibwait  
call, if the DTAS bit is set in the ibwait  mask parameter.

DCAS (brd)
DCAS indicates whether the GPIB interface has detected a device cle
command. DCAS is set whenever the GPIB interface detects that the 
Device Clear (DCL) command has been sent by another Controller, or
whenever the GPIB interface as a Listener detects that the Selected D
Clear (SDC) command has been sent by another Controller.

If you use the ibwait  or ibnotify  function to wait for DCAS and the 
wait is completed, DCAS is cleared from ibsta  after the next NI-488.2 
call. The same is true of reads and writes. If you call a read or write func
such as ibwrt  or Send, and DCAS is set in ibsta , the I/O operation is 
aborted. DCAS is cleared from ibsta  after the next NI-488.2 call.
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Error Codes and Solutions

This appendix lists a description of each error, some conditions under
which it might occur, and possible solutions.

The following table lists the GPIB error codes.

Error 
Mnemonic

iberr 
Value Meaning

EDVR 0 System error

ECIC 1 Function requires GPIB interface to be CIC

ENOL 2 No Listeners on the GPIB

EADR 3 GPIB interface not addressed correctly

EARG 4 Invalid argument to function call

ESAC 5 GPIB interface not System Controller as 
required

EABO 6 I/O operation aborted (timeout)

ENEB 7 Nonexistent GPIB interface

EDMA 8 DMA error

EOIP 10 Asynchronous I/O in progress

ECAP 11 No capability for operation

EFSO 12 File system error

EBUS 14 GPIB bus error

ESTB 15 Serial poll status byte queue overflow

ESRQ 16 SRQ stuck in ON position

ETAB 20 Table problem
nual for Windows
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EDVR (0)
EDVR is returned when the interface or device name passed to ibfind , 
or the interface index passed to ibdev , cannot be accessed. The global 
variable ibcntl  contains an error code. This error occurs when you try to
access an interface or device that is not installed or configured proper

EDVR is also returned if an invalid unit descriptor is passed to any 
traditional NI-488.2 call.

Solutions
Possible solutions for this error are as follows:

• Use ibdev  to open a device without specifying its symbolic name.

• Use only device or interface names that are configured in the NI-48
Configuration utility as parameters to the ibfind  function.

• Use the NI-488.2 Troubleshooting Wizard to ensure that each interf
you want to access is working properly. To start the NI-488.2 
Troubleshooting Wizard, select Start»Programs»National 
Instruments NI-488.2»Explore GPIB, select Measurement & 
Automation in the left window frame, then choose Help» 
Troubleshooting»NI-488.2 Troubleshooting Wizard.

• Use the unit descriptor returned from ibdev  or ibfind  as the first 
parameter in subsequent traditional NI-488.2 calls. Examine the 
variable before the failing function to make sure its value has not b
corrupted.

• Refer to the NI-488.2 online help. To view the online help, select 
Start»Programs»National Instruments NI-488.2»Explore GPIB. 
Then, select a GPIB interface under Devices and Interfaces, 
right-click, and choose NI-488.2 Help.

ECIC (1)
ECIC is returned when one of the following interface functions or routin
is called while the interface is not CIC:

• Any device-level traditional NI-488.2 calls that affect the GPIB.

• Any board-level traditional NI-488.2 calls that issue GPIB comman
bytes: ibcmd , ibcmda , ibln , and ibrpp.
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• ibcac  and ibgts.

• Any NI-488.2 multi-device calls that issue GPIB command bytes: 
SendCmds, PPoll, Send, and Receive.

Solutions
Possible solutions for this error are as follows:

• Use ibsic  or SendIFC  to make the GPIB interface become CIC on
the GPIB.

• Use ibrsc  1 to make sure your GPIB interface is configured as 
System Controller.

• In multiple CIC situations, always be certain that the CIC bit appea
in the status word ibsta  before attempting these calls. If it does not
appear, you can perform an ibwait  (for CIC) call to delay further 
processing until control is passed to the interface.

ENOL (2)
ENOL usually occurs when a write operation is attempted with no 
Listeners addressed. For a device write, ENOL indicates that the GPIB
address configured for that device in the software does not match the G
address of any device connected to the bus, that the GPIB cable is no
connected to the device, or that the device is not powered on.

ENOL can occur in situations where the GPIB interface is not the CIC 
the Controller asserts ATN before the write call in progress has ended

Solutions
Possible solutions for this error are as follows:

• Make sure that the GPIB address of your device matches the GPI
address of the device to which you want to write data.

• Use the appropriate hex code in ibcmd  to address your device.

• Check your cable connections and make sure at least two-thirds o
your devices are powered on.

• Call ibpad  (or ibsad , if necessary) to match the configured addres
to the device switch settings.

• Reduce the write byte count to that which is expected by the Contro
© National Instruments Corporation C-3 NI-488.2 Function Reference Manual for Windows
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EADR (3)
EADR occurs when the GPIB interface is CIC and is not properly 
addressing itself before read and write functions. This error is usually 
associated with board-level functions.

EADR is also returned by the function ibgts  when the shadow-handshake
feature is requested and the GPIB ATN line is already unasserted. In t
case, the shadow handshake is not possible and the error is returned 
notify you of that fact.

Solutions
Possible solutions for this error are as follows:

• Make sure that the GPIB interface is addressed correctly before ca
ibrd , ibwrt , RcvRespMsg, or SendDataBytes .

• Avoid calling ibgts  except immediately after an ibcmd  call. 
(ibcmd causes ATN to be asserted.)

EARG (4)
EARG results when an invalid argument is passed to a function call. T
following are some examples:

• ibtmo  called with a value not in the range 0 through 17.

• ibeos  called with meaningless bits set in the high byte of the seco
parameter.

• ibpad  or ibsad  called with invalid addresses.

• ibppc  called with invalid parallel poll configurations.

• A board-level traditional NI-488.2 call made with a valid device 
descriptor, or a device-level traditional NI-488.2 call made with an
interface descriptor.

• A multi-device NI-488.2 call made with an invalid address.

• PPollConfig  called with an invalid data line or sense bit.

Solutions
Possible solutions for this error are as follows:

• Make sure that the parameters passed to the NI-488.2 call are val

• Do not use a device descriptor in an interface function or vice-vers
NI-488.2 Function Reference Manual for Windows C-4 © National Instruments Corporation
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ESAC (5)
ESAC results when ibsic , ibsre , SendIFC , or EnableRemote  is called 
when the GPIB interface does not have System Controller capability.

Solutions
Give the GPIB interface System Controller capability by calling ibrsc 1  
or by using the NI-488.2 Configuration utility to configure that capabilit
into the software.

EABO (6)
EABO indicates that an I/O operation has been canceled, usually due
to a timeout condition. Other causes are calling ibstop  or receiving the 
Device Clear message from the CIC while performing an I/O operation
Frequently, the I/O is not progressing (the Listener is not continuing to
handshake or the Talker has stopped talking), or the byte count in the
which timed out was more than the other device was expecting.

Solutions
Possible solutions for this error are as follows:

• Use the correct byte count in input functions or have the Talker use
END message to signify the end of the transfer.

• Lengthen the timeout period for the I/O operation using ibtmo .

• Make sure that you have configured your device to send data befo
you request data.

ENEB (7)
ENEB occurs when no GPIB interface exists at the I/O address specifie
the configuration program. This problem happens when the interface is
physically plugged into the system, the I/O address specified during 
configuration does not match the actual interface setting, or there is a 
system conflict with the base I/O address.
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Solutions
Make sure there is a GPIB interface in your computer that is properly 
configured both in hardware and software using a valid base I/O addre
by running the NI-488.2 Troubleshooting Wizard. To run the NI-488.2 
Troubleshooting Wizard, select Start»Programs»National Instruments 
NI-488.2»Explore GPIB, select Measurement & Automation in the left 
window frame, then choose Help»Troubleshooting»NI-488.2 
Troubleshooting Wizard.

EDMA (8)
EDMA occurs if a system DMA error is encountered when the NI-488.
software attempts to transfer data over the GPIB using DMA.

Solutions
Possible solutions for this error are as follows:

• You can correct the EDMA problem in the hardware by using the 
NI-488.2 Configuration utility to reconfigure the hardware not to use
DMA resource.

• You can correct the EDMA problem in the software by using ibdma  to 
disable DMA.

EOIP (10)
EOIP occurs when an asynchronous I/O operation has not finished be
some other call is made. During asynchronous I/O, you can only use 
ibstop , ibnotify , ibwait , and ibonl  or perform other non-GPIB 
operations. If any other call is attempted, EOIP is returned.
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Solutions
Resynchronize the driver and the application before making any furthe
NI-488.2 calls. Resynchronization is accomplished by using one of the
following functions:

ibnotify If the ibsta  value passed to the ibnotify  callback 
contains CMPL, the driver and application are 
resynchronized.

ibwait If the returned ibsta  contains CMPL, the driver and 
application are resynchronized.

ibstop The I/O is canceled; the driver and application are 
resynchronized.

ibonl The I/O is canceled and the interface is reset; the driv
and application are resynchronized.

ECAP (11)
ECAP results when your GPIB interface lacks the ability to carry out a
operation or when a particular capability has been disabled in the softw
and a call is made that requires the capability.

Solutions
Check the validity of the call, or make sure your GPIB interface and th
driver both have the needed capability.

EFSO (12)
EFSO results when an ibrdf  or ibwrtf  call encounters a problem 
performing a file operation. Specifically, this error indicates that the 
function is unable to open, create, seek, write, or close the file being 
accessed. The specific operating system error code for this condition 
contained in ibcntl .
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Solutions
Possible solutions for this error are as follows:

• Make sure the filename, path, and drive that you specified are cor

• Make sure that the access mode of the file is correct.

• Make sure there is enough room on the disk to hold the file.

EBUS (14)
EBUS results when certain GPIB bus errors occur during device functio
All device functions send command bytes to perform addressing and o
bus management. Devices are expected to accept these command by
within the time limit specified by the default configuration or the ibtmo  
function. EBUS results if a timeout occurred while sending these comm
bytes.

Solutions
Possible solutions for this error are as follows:

• Verify that the instrument is operating correctly.

• Check for loose or faulty cabling or several powered-off instrumen
on the GPIB.

• If the timeout period is too short for the driver to send command byt
increase the timeout period.

ESTB (15)
ESTB is reported only by the ibrsp  function. ESTB indicates that one or
more serial poll status bytes received from automatic serial polls have b
discarded because of a lack of storage space. Several older status byt
available; however, the oldest is being returned by the ibrsp  call.

Solutions
Possible solutions for this error are as follows:

• Call ibrsp  more frequently to empty the queue.

• Disable autopolling with the ibconfig  function (option 
IbcAUTOPOLL) or the NI-488.2 Configuration utility. To start the 
NI-488.2 Configuration utility, select Start»Programs»National 
Instruments NI-488.2»Explore GPIB. Then, select the GPIB 
NI-488.2 Function Reference Manual for Windows C-8 © National Instruments Corporation
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interface under Devices and Interfaces in the left window frame, 
right-click, and choose Properties.

ESRQ (16)
ESRQ can only be returned by a device-level ibwait  call with RQS set in 
the mask. ESRQ indicates that a wait for RQS is not possible because
GPIB SRQ line is stuck on. This situation can be caused by the follow
events:

• Usually, a device unknown to the software is asserting SRQ. Beca
the software does not know of this device, it can never serial poll t
device and unassert SRQ.

• A GPIB bus tester or similar equipment might be forcing the SRQ li
to be asserted.

• A cable problem might exist involving the SRQ line.

Although the occurrence of ESRQ warns you of a definite GPIB proble
it does not affect GPIB operations, except that you cannot depend on 
ibsta  RQS bit while the condition lasts.

Solutions
Check to see if other devices not used by your application are assertin
SRQ. Disconnect them from the GPIB if necessary.

ETAB (20)
ETAB occurs only during the FindLstn  and FindRQS functions. ETAB 
indicates that there was some problem with a table used by these func

• In the case of FindLstn , ETAB means that the given table did not 
have enough room to hold all the addresses of the Listeners found

• In the case of FindRQS, ETAB means that none of the devices in the
given table were requesting service.

Solutions
In the case of FindLstn , increase the size of result arrays. In the case o
FindRQS, check to see if other devices not used by your application ar
asserting SRQ. Disconnect them from the GPIB if necessary.
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Technical Support Resources

National Instruments offers technical support through electronic, fax, a
telephone systems. The electronic services include our Web site, an F
site, and a fax-on-demand system. If you have a hardware or software
problem, please first try the electronic support systems. If the informat
available on these systems does not answer your questions, contact o
our technical support centers, which are staffed by applications engine
for support by telephone and fax. To comment on the documentation 
supplied with our products, send e-mail to techpubs@natinst.com .

Web Site
The InstrumentationWeb address is http://www.natinst.com . 

From this Web site you can connect to our Web sites around the world
(http://www.natinst.com/niglobal/ ) and access technical suppor
(http://www.natinst.com/support/ ).

FTP Site
To access our FTP site, log in to our Internet host, ftp.natinst.com , 
asanonymous  and use your e-mail address, such as 
yourname@anywhere.com , as your password. The support files and 
documents are located in the \support  directories.

Fax-on-Demand Support
Fax-on-Demand is a 24-hour information retrieval system containing a
library of documents in English on a wide range of technical informatio
You can access Fax-on-Demand from a touch-tone telephone at 
512 418 1111.

E-Mail Support
You can submit technical support questions to the applications enginee
team through e-mail at support@natinst.com . Remember to include 
your name, address, and phone number so we can contact you with 
solutions and suggestions.
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Telephone and Fax Support
National Instruments has branch offices all over the world. Use the 
following list to find the technical support number for your country. If the
is no National Instruments office in your country, contact the source fro
which you purchased your software to obtain support.

Country Telephone Fax

Australia 03 9879 5166 03 9879 6277

Austria 0662 45 79 90 0 0662 45 79 90 19

Belgium 02 757 00 20 02 757 03 11

Brazil 011 284 5011 011 288 8528

Canada (Ontario) 905 785 0085 905 785 0086

Canada (Québec) 514 694 8521 514 694 4399

Denmark 45 76 26 00 45 76 26 02

Finland 09 725 725 11 09 725 725 55

France 0 1 48 14 24 24 0 1 48 14 24 14

Germany 089 741 31 30 089 714 60 35

Hong Kong 2645 3186 2686 8505

India 91805275406 91805275410

Israel 03 6120092 03 6120095

Italy 02 413091 02 4139215

Japan 03 5472 2970 03 5472 2977

Korea 02 596 7456 02 596 7455

Mexico (D.F.) 5 280 7625 5 520 3282

Mexico (Monterrey) 8 357 7695 8 365 8543

Netherlands 0348 433466 0348 430673

Norway 32 84 84 00 32 84 86 00

Singapore 2265886 2265887

Spain (Madrid) 91 640 0085 91 640 0533

Spain (Barcelona) 93 582 0251 93 582 4370

Sweden 08 587 895 00 08 730 43 70

Switzerland 056 200 51 51 056 200 51 55

Taiwan 02 2377 1200 02 2737 4644

United Kingdom 01635 523545 01635 523154

United States 512 795 8248 512 794 5678
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Prefix Meaning Value

p- pico- 10–12

n- nano- 10–9

µ- micro- 10– 6

m- milli- 10–3

k- kilo- 103

M- mega- 106

G- giga- 109

t- tera- 1012

A

acceptor handshake Listeners use this GPIB interface function to receive data, and all d
use it to receive commands. See source handshake and handshake.

access interface The GPIB interface that controls and communicates with the devices 
bus that are attached to it.

ANSI American National Standards Institute.

API Application Programmer Interface

ASCII American Standard Code for Information Interchange.

asynchronous An action or event that occurs at an unpredictable time with respect 
execution of a program.

automatic serial polling 
(autopolling)

A feature of the NI-488.2 software in which serial polls are executed 
automatically by the driver whenever a device asserts the GPIB SRQ 
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base I/O address See I/O address.

BIOS Basic Input/Output System.

board-level function A rudimentary function that performs a single operation.

C

CFE 
(Configuration Enable)

The GPIB command which precedes CFGn and is used to place devic
into their configuration mode.

CFGn These GPIB commands (CFG1 through CFG15) follow CFE and are u
to configure all devices for the number of meters of cable in the system
that HS488 transfers occur without errors.

CIC 
(Controller-In-Charge)

The device that manages the GPIB by sending interface messages to 
devices.

CPU Central processing unit.

D

DAV (Data Valid) One of the three GPIB handshake lines. See handshake.

DCL (Device Clear) The GPIB command used to reset the device or internal functions of 
devices. See SDC.

device-level function A function that combines several rudimentary board operations into o
function so that the user does not have to be concerned with bus 
management or other GPIB protocol matters. 

DIO1 through DIO8 The GPIB lines that are used to transmit command or data bytes from
device to another.

DLL Dynamic link library.

DMA (direct 
memory access)

High-speed data transfer between the GPIB interface and memory tha
not handled directly by the CPU. Not available on some systems. 
Seeprogrammed I/O.

driver Device driver software installed within the operating system. 
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END or 
END Message

A message that signals the end of a data string. END is sent by assertin
GPIB End or Identify (EOI) line with the last data byte.

EOI A GPIB line that is used to signal either the last byte of a data messag
(END) or the parallel poll Identify (IDY) message.

EOS or EOS Byte A 7- or 8-bit end-of-string character that is sent as the last byte of a d
message.

EOT End of transmission 

ESB The Event Status bit is part of the IEEE 488.2-defined status byte whic
received from a device responding to a serial poll.

G

GET (Group 
Execute Trigger)

Group Execute Trigger is the GPIB command used to trigger a device
internal function of an addressed Listener.

GPIB General Purpose Interface Bus is the common name for the 
communications interface system defined in ANSI/IEEE Standard 
488.1-1987 and ANSI/IEEE Standard 488.2-1992. 

GPIB address The address of a device on the GPIB, composed of a primary address
and MTA) and perhaps a secondary address (MSA). The GPIB interfa
has both a GPIB address and an I/O address.

GPIB interface Refers to the National Instruments family of GPIB interfaces.

GTL (Go To Local) Go To Local is the GPIB command used to place an addressed Listen
local (front panel) control mode.
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handshake The mechanism used to transfer bytes from the Source Handshake fu
of one device to the Acceptor Handshake function of another device. 
The three GPIB lines DAV, NRFD, and NDAC are used in an interlocke
fashion to signal the phases of the transfer so that bytes can be sent 
asynchronously (for example, without a clock) at the speed of the slow
device. For more information about handshaking, refer to the ANSI/IE
Standard 488.1-1987.

hex Hexadecimal; a number represented in base 16. For example, 
decimal 16 = hex 10.

high-level function See device-level function.

Hz Hertz.

I

ibcnt After each NI-488.2 I/O call, this global variable contains the actual 
number of bytes transmitted.

iberr A global variable that contains the specific error code associated with 
function call that failed.

ibsta At the end of each function call, this global variable (status word) conta
status information.

IEEE Institute of Electrical and Electronic Engineers.

interface message A broadcast message sent from the Controller to all devices and us
manage the GPIB. 

I/O address The address of the GPIB interface from the point of view of the CPU
as opposed to the GPIB address of the GPIB interface. Also called po
address or interface address.

I/O (Input/Output) In the context of this document, the transmission of commands or mes
between the computer through the GPIB interface and other devices on
GPIB.

ist An Individual Status bit of the status byte used in the Parallel Poll 
Configure function.
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LAD (listen address) See MLA .

language interface Code that enables an application program that uses NI-488.2 calls to a
the driver.

Listener A GPIB device that receives data messages from a Talker.

LLO (Local Lockout) The GPIB command used to tell all devices that they may or should ignore 
remote (GPIB) data messages or local (front panel) controls, dependin
whether the device is in local or remote program mode.

low-level function A rudimentary Controller-In-Charge or device function that performs a 
single operation. 

M

m Meters.

MAV The Message Available bit is part of the IEEE 488.2-defined status byte 
which is received from a device responding to a serial poll.

MB Megabytes of memory.

memory-resident Resident in RAM.

MLA (My Listen 
Address)

A GPIB command used to address a device to be a Listener. It can be any 
one of the 31 primary addresses.

MSA (My Secondary 
Address)

The GPIB command used to address a device to be a Listener or a Talker 
when extended (two byte) addressing is used. The complete address 
is a MLA or MTA address followed by an MSA address. There are 
31 secondary addresses for a total of 961 distinct listen or talk address
for devices.

MTA (My Talk Address) A GPIB command used to address a device to be a Talker. It can be any one 
of the 31 primary addresses.

multitasking The concurrent processing of more than one program or task. 
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NDAC (Not Data 
Accepted)

One of the three GPIB handshake lines. See handshake.

NRFD (Not Ready 
For Data)

One of the three GPIB handshake lines. See handshake.

P

parallel poll The process of polling all configured devices at once and reading a 
composite poll response. See serial poll.

PIO See programmed I/O.

PPC (Parallel 
Poll Configure)

Parallel Poll Configure is the GPIB command used to configure an 
addressed Listener to participate in polls.

PPD (Parallel 
Poll Disable)

Parallel Poll Disable is the GPIB command used to disable a configured 
device from participating in polls. There are 16 PPD commands.

PPE (Parallel 
Poll Enable)

Parallel Poll Enable is the GPIB command used to enable a configured 
device to participate in polls and to assign a DIO response line. There 
are 16 PPE commands.

PPU (Parallel Poll 
Unconfigure)

Parallel Poll Unconfigure is the GPIB command used to disable used to
disable any device from participating in polls.

programmed I/O Low-speed data transfer between the GPIB interface and memory in 
which the CPU moves each data byte according to program instructions. 
See DMA.

R

RAM Random-access memory.

resynchronize The NI-488.2 software and the user application must resynchronize af
asynchronous I/O operations have completed.

RQS Request Service.
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f the 
S

s Seconds.

SDC (Selected 
Device Clear)

The GPIB command used to reset internal or device functions of an 
addressed Listener. See DCL.

serial poll The process of polling and reading the status byte of one device at a time. 
See parallel poll.

service request See SRQ.

source handshake The GPIB interface function that transmits data and commands. Talkers use 
this function to send data, and the Controller uses it to send command
See acceptor handshake and handshake.

SPD (Serial Poll Disable) The GPIB command used to cancel an SPE command.

SPE (Serial Poll Enable) The GPIB command used to enable a specific device to be polled. 
That device must also be addressed to talk. See SPD.

SRQ (Service Request) The GPIB line that a device asserts to notify the CIC that the device needs 
servicing.

status byte The IEEE 488.2-defined data byte sent by a device when it is serially 
polled.

status word See ibsta .

synchronous Refers to the relationship between the NI-488.2 driver functions and a 
process when executing driver functions is predictable; the process is 
blocked until the driver completes the function.

System Controller The single designated Controller that can assert control (become CIC o
GPIB) by sending the Interface Clear (IFC) message. Other devices can 
become CIC only by having control passed to them.
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TAD (Talk Address) See MTA.

Talker A GPIB device that sends data messages to Listeners.

TCT (Take Control) The GPIB command used to pass control of the bus from the current
Controller to an addressed Talker.

timeout A feature of the NI-488.2 driver that prevents I/O functions from hangi
indefinitely when there is a problem on the GPIB.

TLC An integrated circuit that implements most of the GPIB Talker, Listene
and Controller functions in hardware.

U

ud (unit descriptor) A variable name and first argument of each function call that contains
unit descriptor of the GPIB interface or other GPIB device that is the ob
of the function. 

UNL (Unlisten) The GPIB command used to unaddress any active Listeners.

UNT (Untalk) The GPIB command used to unaddress an active Talker.
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A
address functions

IBPAD, 1-48
IBSAD, 1-63

AllSpoll routine, 2-4
asynchronous operations, halting, 1-66
ATN status word condition, B-4

B
board configuration parameter options.  See 

configuration options.
board level functions (table), 1-3 to 1-5

C
callback, 1-43 to 1-46
CIC status word condition, B-4
clear functions and routines

DevClear, 2-5
DevClearList, 2-6
IBCLR, 1-15
IBIST, 1-36
IBSIC, 1-64
IBSRE, 1-65
SendIFC, 2-25

CMPL status word condition, B-3
command functions and routines

IBCMD, 1-16
IBCMDA, 1-18 to 1-19
SendCmds, 2-23

configuration functions
IBASK, 1-6 to 1-11
IBCONFIG, 1-20 to 1-25

configuration options
IBASK function

board configuration parameter 
options, 1-7 to 1-9

device configuration parameter 
options, 1-10 to 1-11

IBCONFIG function
board level configuration options, 

1-21 to 1-24
device level configuration options, 

1-24 to 1-25
control line status, 1-37 to 1-38
controller functions and routines

IBCAC, 1-13 to 1-14
IBGTS, 1-34 to 1-35
IBPCT, 1-49
IBRSC, 1-59
PassControl, 2-11

D
DCAS status word condition, B-5
DevClear routine, 2-5
DevClearList routine, 2-6
device configuration parameter options.  See 

configuration options.
device level functions (table), 1-2 to 1-3
DMA function, 1-28
documentation

conventions used in manual, xii
overview of the NI-488.2 documentation, xi
related documentation, xii

DTAS status word condition, B-5
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E
EABO error code, C-5
EADR error code, C-4
EARG error code, C-4
EBUS error code, C-8
ECAP error code, C-7
ECIC error code, C-2 to C-3
EDMA error code, C-6
EDVR error code, C-2
EFSO error code, C-7 to C-8
EnableLocal routine, 2-7
EnableRemote routine, 2-8
END status word condition, B-2
ENEB error code, C-5 to C-6
ENOL error code, C-3
EOI line, enabling or disabling, 1-30
EOIP error code, C-6 to C-7
EOS byte, defining, 1-29
EOS configurations, 1-30
ERR status word condition, B-2
error codes, C-1 to C-9.  See also specific 

functions and routines.
ESAC error code, C-5
ESRQ error code, C-9
ESTB error code, C-8 to C-9
ETAB error code, C-9

F
fax-on-demand support, D-1
FindLstn routine, 2-9 
FindRQS routine, 2-10
functions.  See NI-488.2 functions and 

functions for multithreaded applications.
functions for multithreaded applications

alphabetical list of functions (table), 3-2
ThreadIbcnt, 3-3
ThreadIbcntl, 3-4
ThreadIberr, 3-5
ThreadIbsta, 3-6

G
GPIB error codes (table), C-1

I
IbaAUTOPOLL configuration option, 1-7
IbaBNA configuration option, 1-10
IbaCICPROT configuration option, 1-7
IbaDMA configuration option, 1-7
IbaEndBitIsNormal configuration option, 1-7
IbaEOSchar configuration option

boards, 1-7
devices, 1-10

IbaEOScmp configuration option
boards, 1-7
devices, 1-10

IbaEOSrd configuration option
boards, 1-7
devices, 1-10

IbaEOSwrt configuration option
boards, 1-8
devices, 1-10

IbaEOT configuration option
boards, 1-8
devices, 1-10

IbaHSCableLength configuration option, 1-8
IbaIst configuration option, 1-8
IbaPAD configuration option

boards, 1-8
devices, 1-10

IbaPP2 configuration option, 1-8
IbaPPC configuration option, 1-8
IbaPPollTime configuration option, 1-9
IbaReadAdjust configuration option

boards, 1-9
devices, 1-10

IbaREADDR configuration option, 1-10
IbaRsv configuration option, 1-9
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IbaSAD configuration option
boards, 1-9
devices, 1-10

IbaSC configuration option, 1-9
IbaSendLLO configuration option, 1-9
IBASK function, 1-6 to 1-11

board configuration parameter 
options, 1-7 to 1-9

description, 1-6
device configuration parameter 

options, 1-10 to 1-11
IbaSPollTime configuration option, 1-10
IbaSRE configuration option, 1-9
IbaTIMING configuration option, 1-9
IbaTMO configuration option

boards, 1-9
devices, 1-10

IbaUnAddr configuration option, 1-11
IbaWriteAdjust configuration option

boards, 1-9
devices, 1-11

IBBNA function, 1-12
IBCAC function, 1-13 to 1-14
IbcAUTOPOLL configuration option, 1-21
IbcCICPROT configuration option, 1-21
IbcDMA configuration option, 1-21
IbcEndBitIsNormal configuration 

option, 1-21
IbcEOSchar configuration option

board level, 1-21
device level, 1-24

IbcEOScmp configuration option
board level, 1-21
device level, 1-24

IbcEOSrd configuration option
board level, 1-21
device level, 1-24

IbcEOSwrt configuration option
board level, 1-22
device level, 1-24

IbcEOT configuration option
board level, 1-22
device level, 1-24

IbcHSCableLength configuration option, 1-2
IbcIst configuration option, 1-22
IBCLR function, 1-15
IBCMD function, 1-16 to 1-17
IBCMDA function, 1-18 to 1-19
IBCONFIG function, 1-20 to 1-25

board level configuration options, 
1-21 to 1-24

description, 1-20
device level configuration options, 

1-24 to 1-25
IbcPAD configuration option

board level, 1-22
device level, 1-24

IbcPP2 configuration option, 1-22
IbcPPC configuration option, 1-23
IbcPPollTime configuration option, 1-23
IbcReadAdjust configuration option

board level, 1-23
device level, 1-24

IbcREADDR configuration option, 1-24
IbcRsv configuration option, 1-23
IbcSAD configuration option

board level, 1-23
device level, 1-24

IbcSC configuration option, 1-23
IbcSendLLO configuration option, 1-23
IbcSPollTime configuration option, 1-24
IbcSRE configuration option, 1-23
IbcTIMING configuration option, 1-23
IbcTMO configuration option

board level, 1-24
device level, 1-24

IbcUnAddr configuration option, 1-24
IbcWriteAdjust configuration option

board level, 1-24
device level, 1-24
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IBDEV function, 1-26 to 1-27
IBDMA function, 1-28
IBEOS function, 1-29 to 1-30
IBEOT function, 1-31
IBFIND function, 1-32 to 1-33
IBGTS function, 1-34 to 1-35
IBIST function, 1-36
IBLINES function, 1-37 to 1-38
IBLN function, 1-39 to 1-40
IBLOC function, 1-41 to 1-42
IBNOTIFY function, 1-43 to 1-46
IBONL function, 1-47
IBPAD function, 1-48
IBPCT function, 1-49
IBPPC function, 1-50 to 1-51
IBRD function, 1-52 to 1-53
IBRDA function, 1-54 to 1-55
IBRDF function, 1-56 to 1-57
IBRPP function, 1-58
IBRSC function, 1-59
IBRSP function, 1-60 to 1-61
IBRSV function, 1-62
IBSAD function, 1-63
IBSIC function, 1-64
IBSRE function, 1-65
ibsta (status word).  See status word 

conditions.
IBSTOP function, 1-66
IBTMO function, 1-67 to 1-68
IBTRG function, 1-69
IBWAIT function, 1-70 to 1-71
IBWRT function, 1-72 to 1-73
IBWRTA function, 1-74 to 1-75
IBWRTF function, 1-76 to 1-77
interface clear functions and routines

IBSIC, 1-64
SendIFC, 2-25

L
LACS status word condition, B-5
listeners, finding

FindLstn routine, 2-9 
IBLN function, 1-39 to 1-40

local functions and routines
EnableLocal, 2-7
IBLOC, 1-41 to 1-42
SendLLO, 2-27

lockout routines
SendLLO, 2-27
SetRWLS, 2-29

LOK status word condition, B-3

M
manual.  See documentation.
multiline interface messages, A-1 to A-4

N
NI-488.2 functions

alphabetical list of functions (table), 
1-2 to 1-5

board-level functions (table), 1-3 to 1-5
device-level functions (table), 1-2 to 1-3
IBASK function, 1-6 to 1-11
IBBNA, 1-12
IBCAC, 1-13 to 1-14
IBCLR, 1-15
IBCMD, 1-16 to 1-17
IBCMDA, 1-18 to 1-19
IBCONFIG, 1-20 to 1-25
IBDEV function, 1-26 to 1-27
IBDMA function, 1-28
IBEOS function, 1-29 to 1-30
IBEOT function, 1-31
IBFIND function, 1-32 to 1-33
IBGTS function, 1-34 to 1-35
IBIST function, 1-36
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IBLINES function, 1-37 to 1-38
IBLN function, 1-39 to 1-40
IBLOC function, 1-41 to 1-42
IBNOTIFY function, 1-43 to 1-46
IBONL function, 1-47
IBPAD function, 1-48
IBPCT function, 1-49
IBPPC function, 1-50 to 1-51
IBRD function, 1-52 to 1-53
IBRDA function, 1-54 to 1-55
IBRDF function, 1-56 to 1-57
IBRPP function, 1-58
IBRSC function, 1-59
IBRSP function, 1-60 to 1-61
IBRSV function, 1-62
IBSAD function, 1-63
IBSIC function, 1-64
IBSRE function, 1-65
IBSTOP function, 1-66
IBTMO function, 1-67 to 1-68
IBTRG function, 1-69
IBWAIT function, 1-70 to 1-71
IBWRT function, 1-72 to 1-73
IBWRTA function, 1-74 to 1-75
IBWRTF function, 1-76 to 1-77

NI-488.2 routines
AllSpoll, 2-4
alphabetical list of routines 

(table), 2-2 to 2-3
DevClear, 2-5
DevClearList, 2-6
EnableLocal, 2-7
EnableRemote, 2-8
FindLstn, 2-9 
FindRQS, 2-10
PassControl, 2-11
PPoll, 2-12
PPollConfig, 2-13 to 2-14
PPollUnconfig, 2-15
RcvRespMsg, 2-16 to 2-17
ReadStatusByte, 2-18

Receive, 2-19
ReceiveSetup, 2-20
ResetSys, 2-21
Send, 2-22
SendCmds, 2-23
SendDataBytes, 2-24
SendIFC, 2-25
SendList, 2-26
SendLLO, 2-27
SendSetup, 2-28
SetRWLS, 2-29
TestSRQ, 2-30
TestSys, 2-31 to 2-32
Trigger, 2-33
TriggerList, 2-34
WaitSRQ, 2-35

notify function, 1-43 to 1-46
notify mask layout (table), 1-44

O
online/offline function, 1-47

P
parallel polling functions and routines

IBIST, 1-36
IBPPC, 1-50 to 1-51
IBRPP, 1-58
PPoll, 2-12
PPollConfig, 2-13 to 2-14
PPollUnconfig, 2-15

PassControl routine, 2-11
PPoll routine, 2-12
PPollConfig routine, 2-13 to 2-14
PPollUnconfig routine, 2-15
primary address, changing, 1-48
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R
RcvRespMsg routine, 2-16 to 2-17
read functions

IBRD, 1-52 to 1-53
IBRDA, 1-54 to 1-55
IBRDF, 1-56 to 1-57

ReadStatusByte routine, 2-18
Receive routine, 2-19
ReceiveSetup routine, 2-20
REM status word condition, B-4
remote functions and routines

EnableRemote, 2-8
IBSRE, 1-65
SetRWLS, 2-29

ResetSys routine, 2-21
routines.  See NI-488.2 routines.
RQS status word condition, B-3

S
Send routine, 2-22
SendCmds routine, 2-23
SendDataBytes routine, 2-24
SendIFC routine, 2-25
SendList routine, 2-26
SendLLO routine, 2-27
SendSetup routine, 2-28
serial polling functions and routines

AllSpoll, 2-4
IBRSP, 1-60 to 1-61
IBRSV, 1-62
ReadStatusByte, 2-18

service request routines
FindRQS, 2-10
TestSRQ, 2-30

SetRWLS routine, 2-29
SRQ functions and routines

TestSRQ, 2-30
WaitSRQ, 2-35

SRQI status word condition, B-3

status word conditions
ATN, B-4
CIC, B-4
CMPL, B-3
DCAS, B-5
DTAS, B-5
END, B-2
ERR, B-2
ibsta (status word) layout (table), B-1
LACS, B-5
LOK, B-3
REM, B-4
RQS, B-3
SRQI, B-3
TACS, B-4
TIMO, B-2

T
TACS status word condition, B-4
technical support, D-1 to D-2
TestSRQ routine, 2-30
TestSys routine, 2-31 to 2-32
ThreadIbcnt function, 3-3
ThreadIbcntl function, 3-4
ThreadIberr function, 3-5
ThreadIbsta function, 3-6
timeout code values (table), 1-67 to 1-68
TIMO status word condition, B-2
trigger functions and routines

IBTRG, 1-69
Trigger, 2-33
TriggerList, 2-34

Trigger routine, 2-33
TriggerList routine, 2-34
NI-488.2 Function Reference Manual for Windows I-6 © National Instruments Corporation



Index
W
wait functions and routines

IBWAIT, 1-70 to 1-71
WaitSRQ, 2-35

wait mask layout (table), 1-71
WaitSRQ routine, 2-35
write functions

IBWRT, 1-72 to 1-73
IBWRTA, 1-74 to 1-75
IBWRTF, 1-76 to 1-77
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